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Chapter 1

Introduction

Usethe Gentran Integration Suite4.3 Windows Non-Cluster Installation Guideto install Gentran Integration
Suite 4.3 in anon-clustered (single node) Windows environment.

This guide focuses on these installation tasks, including:

Setting up the database

Installing the Gentran Integration Suite software

(If licensed) Installing and configuring MESA Developer Studio

Configuring propertiesfiles

Configuring installation utilities

Configuring Gentran Integration Suite for a non-English environment

For upgrades, use the Gentran Integration Suite 4.3 Windows Non-Cluster Upgrade Guide.

e e e+
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Chapter 2

Setting Up the Database (Windows)

Creating and Configuring the Database Server (Windows)
You must install, create, and configure a database so that each Gentran Integration Suite instance has a
dedicated schemaand login for the database.

Caution: If you arereinstalling Gentran I ntegration Suite, be aware that datain your existing database will
be deleted. To prevent this, either back up the existing database or save it under a different name

Caution: After creating and configuring your database, recyclethe database. Then stop and restart Gentran
Integration Suite to apply the changes.

In a Windows environment, Gentran Integration Suite supports the following databases:
4+ Oracle9i or 10g
For more information, refer to Installing Oracle on page 8.

4+ Microsoft SQL Server 2000
For more information, refer to Installing Microsoft SQL Server 2000/2005 on page 14.

4 Microsoft SQL Server 2005
For more information, refer to Installing Microsoft SQL Server 2000/2005 on page 14.
4+ DB2
For more information, refer to Installing DB2 on page 16.
4+ MySQL (non-clustered only)
For more information, refer to Using a MySQL Database Server (Non-Clustered Only) on page 18.

See System Requirements for supported version information.

Database Sizing

Database sizing is designed to give you estimates of the database growth and to assist in planning the disk
reguirements.

Capacity Planning

Sterling Commerce, an IBM Company 7



Creating and Configuring the Database Server (Windows)

There are many factors to consider when estimating the amount of disk space that will be required for
Gentran Integration Suite. As aresult, trying to consider all growth factors is impractical because the user
may not know the answers to many questions that are required to do a detailed forecast. Over the years the
cost of disks has dramatically decreased, and the capacity and speed of disks hasincreased. The method of
how information system managers order disk capacity has also changed from purchasing disk arrays that
are dedicated to a particular database server and project to the concept of SANS.

Gentran Integration Suite provides a methodology to estimate your initial disk requirements. Consider the
confidence that you have in your data estimates when making the final purchase decision and adjust
accordingly. After theinitia purchase and production deployment, disk growth should be tracked for future
purchase forecasts.

Tracking and Estimating Future Disk Requirements

Y ou should regularly track your actual database storage usage and number of database records. Correlating
these two metrics enabled you to plan your future disk requirements. Moreover, determining the average
amount of space used for each order line or shipment line, enables you to accurately predict your future
growth requirements.

Installing Oracle

Y ou can use an Oracle database for maintaining information on Gentran Integration Suite. The following
sections provide the necessary steps to install and configure an Oracle database for production:

4 Choosing a Character Set on page 8
4 Oracle Database User Privileges on page 9
4+ Configuring an Oracle Database for Production on page 10

Choosing a Character Set
Toinstall Oracle with single or multiple byte characters, perform these steps:

1. If you do not have Oracleinstalled, perform the installation procedures in your Oracle Installation
manuals.

2. Runthe create instance procedure. Use a character set appropriate for your desired language, using the
following command:

CHARACTER SET " AL32UTF8"

Sterling Commerce, an IBM Company 8



3.

Creating and Configuring the Database Server (Windows)

Configurethe | NI T<I NSTANCE_NAME>. ORA file for Oracle as follows:

open_cursors= <set to appropriate val ue>

For example, the minimum value for WebL ogic equals number of threads (across al application
servers) + (connection pool size X prepared statement pool size).

cursor _shari ng=exact

conpati bl e=<10. 2. 0. 1>

tinmed statistics=true

db_bl ock_si ze=8192

optim zer _node=CHOCSE

If you are using multi-byte character set, set the following and restart Oracle:

nl s_| engt h_senmanti cs=CHAR

Alternatively you can run:

alter session set nls |length _senmantics = CHAR

prior to running any create table scripts.

Setting this attribute ensures that the field sizes are not impacted by the number of bytes a data type

can store. For example, Varchar(40) would now be able to store 40 Japanese characters instead of 40/3
bytesin the AL32UTF-8 character set.

Note: When you change the multi-byte character set to CHAR by setting nls_length_semantics =
CHAR, Oracle reserves space equivalent to 'n' chars, which is more than 'n' bytes. Therefore, when
you run thedbveri f y. cnd command, the reduced entries in table columns are printed in the
Yantra_TableDrops.sql file.

Download the Oracle JDBC driver ojdbcl4.jar from the Oracle web site and copy to awell-known
location for reference during installation.

Oracle Database User Privileges
Caution: The access given by these Oracle permissions might violate your internal security policies, since

they give the Gentran Integration Suite user access to all schemasin the Oracle database. You
might need to refine your permissions to give the user access to just the necessary non-Gentran
Integration Suite database objects.

Unless specifically stated for a given task, Gentran Integration Suite user does not require database
administrator (DBA) privileges.

The following are some of the basic privileges that are given to Gentran Integration Suite administrative
user who isinvolved in creating and modifying the Oracle database:

R R

ALTER SESSION
CREATE PROCEDURE
CREATE SEQUENCE
CREATE SESSION
CREATE SYNONYM
CREATE TABLE
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Creating and Configuring the Database Server (Windows)

CREATE VIEW

EXECUTE ANY PROCEDURE
INSERT ANY TABLE
UPDATE ANY TABLE
SELECT ANY TABLE

Thefollowing are some of the basic privileges given to the application user whose involvement isrestricted
just to running the application:

4+ ALTER SESSION

EXECUTE ANY PROCEDURE
INSERT ANY TABLE
UPDATE ANY TABLE
SELECT ANY TABLE

R

¢4+

Configuring an Oracle Database for Production

Y ou need to configure your Oracle database for running in a production environment with Gentran
Integration Suite. To configure an Oracle database for a production environment, you must:

4 Size the database by estimating the required disk space. For more information, refer to Database
Szing on page 7.

4+ Createviews and db_link or synonyms for integrating with the Sterling Warehouse Management
System installation.

4 Set the database connection properties.

To create the Oracle database to handle multiple byte characters, do the following:
1. Do not modify Gentran Integration Suite DDL.

2. Choose the correct data encoding format for your language.

3. Choose the character set suitable for your language.

To configure Oracle database for your production environment manually, you must set up and run a series
of scriptsto create the tables, indexes, sequences, and so forth for your schema.

These script files reside in the\install_dir\install\database\oracle\scripts directory. The table, index, and
sequence creation DDL sare created during installation. Theseresidein\install_dir\install\repository\scripts
directory.

To set up scripts (if you are using locally managed tablespaces or another utility to size your database), do
the following:

1. Create tablespaces where the Gentran Integration Suite tables and indexes reside.

2. If you are manually creating database tables after installation (instead of having installation create
them automatically), do the following:

Modify the\install_dir\install\repository\scripts\EFrame_TableChanges.sql file to reference your
newly created tablespaces.
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Creating and Configuring the Database Server (Windows)

The DDLsin the Gentran Integration Suite scripts create a standard set of indexes. Y ou may need to create
additional indexes or modify existing indexes according to your business practice.

To run the scripts, do the following:

N o g b~ Db P

Log into the Oracle server manager assysdba.

Create the user that is the designated schema owner.

Grant the privileges listed in the Installation Checklist to the newly created user.

Log out of the Oracle Server Manager and log back in as the newly created user.

Verify the database.

Load Gentran Integration Suite database factory defaults.

Check for the degree of parallelism, using information from the Application Performance

Management Guide.

Using an Oracle Database Server

Y ou can use an Oracle 9i or 10g database with Gentran Integration Suite. See System Requirements for
supported version information.

To use an Oracle 9i or 10g database, follow this process:

4+ Create the database. Refer to the Oracle documentation for information about creating the database,
including creating a schema repository, login, and tablespace. Be sureto install the correct version and
patches.

4+ Configure the database by completing the following tasks:

*

*

*

*

*

Setting Database Parametersin Oracle on page 11

Roalling Back or Undoing Changesin Oracle on page 12

Granting Permissionsin Oracle on page 12

Installing the JDBC Driver in Oracle (Windows) on page 13

Enabling Failover in a Multiple Node Oracle RAC Database Cluster (Windows) on page 13

Setting Database Parameters in Oracle

Gentran Integration Suite requires the following parameter settingsin your Oracle database:

Parameter Value

Number of open cursors Greater than or equal to 2000
cursor_sharing EXACT

Database block buffers Greater than or equal to 19200

Note: Sterling Commerce recommends that this be set to O if
SGA memory equals greater than 0.
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Creating and Configuring the Database Server (Windows)

Parameter Value

System Global Area (SGA) Greater than O

memory (10g only) Note: Sterling Commerce recommends that the database
block buffers be set to 0 if SGA memory equals greater
than 0.

Shared pool size Greater than or equal to 90000000

Large pool size Greater than or equal to 614400

Java pool size Greater than or equal to 20971520

Number of processes Greater than or equal to 500

Log buffer Greater than or equal to 163840

Database block size Greater than or equal to 8192

Sort area size Greater than or equal to 65536

Sort area retained size Greater than or equal to 65536

Max extends Unlimited

Character set AL32UTF8

Rolling Back or Undoing Changes in Oracle

Y ou can roll back or undo changes in Oracle using one of the following methods:

<+

(Oracle versions earlier than 9i) Gentran Integration Suite recommends that you configure arollback
segment for every four concurrent users. Each rollback segment must be extendable to 25 MB. The
values of the initial segment and the next segment can vary between 256 KB and 10 MB. Note that
these ranges will vary based on the size of your Gentran Integration Suite database and the number of
business rules it contains.

(Oracle versions 9i or later) These versions support AUTO UNDO management. It is recommended
that you use this option. This will avoid any manual monitoring of UNDO segments.

If aserver isupgraded from Oracle 8i, set the UNDO_MANAGEMENT=AUTO parameter in
init<SID>.ora. Your database administrator needs to figure out the UNDO_RETENTION setting.
Make sure that the file system which has the UNDOTBSL tablespace has enough space to
AUTOGROW.

Granting Permissions in Oracle

Grant the following permissions to a Gentran Integration Suite user:

GRANT " CONNECT" TO <USER>

GRANT SELECT_CATALOG ROLE TO <USER>

ALTER USER <USER>DEFAULT ROLE " CONNECT",
SELECT_CATALOG ROLE

GRANT CREATE PROCEDURE TO <USER>

GRANT CREATE TRI GGER TO <USER>

GRANT CREATE TYPE TO <USER>

GRANT EXECUTE ANY PROCEDURE TO <USER>

GRANT EXECUTE ANY TYPE TO <USER>
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Creating and Configuring the Database Server (Windows)

GRANT SELECT ANY TABLE TO <USER>
GRANT SELECT ANY DI CTI ONARY TO <USER>

For Oracle 10g 10.2.x, aso grant the following permission:

GRANT " RESOURCE" TO <USER>;
ALTER USER <USER> DEFAULT ROLE " CONNECT", " RESOURCE", SELECT_CATALOG ROLE;

Note: If you are using Oracle AQ for Oracle 9i or Oracle 10g, then grant the
AQ_ADMINISTRATOR_ROLE permission.

Installing the JDBC Driver in Oracle (Windows)

Gentran Integration Suite reguires the appropriate JDBC driver for Oracle Database 10g and Oracle 9i
databases. These drivers are thin client based pure Java JDBC drivers. See System Requirements for
supported version information.

The supported versions of the JDBC driver will build the correct Gentran Integration Suite directory
structure.

After obtaining the correct JDBC driver, record the absolute path to its location on your system. Y ou must
supply this absolute path when installing Gentran Integration Suite.

Enabling Failover in a Multiple Node Oracle RAC Database Cluster (Windows)
To enable failover in amultiple node Oracle RAC database cluster in Windows, do the following:

1. Navigateto theinstall_dir/install/properties directory to modify sandbox.cfg file.

2. Inthe sandbox.cfg file, add a new property for ORACLE_JDBC_URL, which contains the Oracle
RAC connection URL.
The following example shows the suggested URL form and the way it is organized. However, the
property value must be one string of text starting with ORACLE_JDBC_URL=. Your database
administrator (DBA) can modify this URL as needed.

jdbc:oracle:thin: @
( DESCRI PTI ON=
( ADDRESS LI ST=
( FAI LOVER=ON)
( LOAD_BALANCE=CFF)
( ADDRESS=( PROTOCOL=TCP) ( HOST=nyhost 1) ( PORT=1521) )
( ADDRESS=( PROTOCOL=TCP) ( HOST=nyhost 2) ( PORT=1521))
)
( CONNECT_DATA = ( SERVER = DEDI CATED) ( SERVI CE_NAME = nyservi cenane))
)
3. Runtheset upfil es. sh command from theinstall_dir/install/bin directory.

4. Set the propagation delay on the RAC server to 0.
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Creating and Configuring the Database Server (Windows)

Installing Microsoft SQL Server 2000/2005

Y ou can use a Microsoft SQL Server 2000/2005 database for maintaining information on Gentran
Integration Suite. When using aMicrosoft SQL Server database with Gentran Integration Suite, see System
Reqguirements for supported version information.

If you do not have SQL Server installed, follow theinstallation proceduresin your SQL Server installation
manual. Refer to the SQL Server documentation for information about creating the database, including
creating a schema repository, login, and tablespace. Be sure to install the correct version and patch.

Note: Ensurethat TCP/IP protocols are enabled in the network utility of the SQL Server.

Note: For SQL Server 2005, do not use case-sensitive column namesin the database. Case-sensitive names
will prevent the SQL Server 2005 System Management Console from loading.

Setting Database Parameters in SQL Server

To create a database, ensure that the collation property you select supports all the characters for your
database.

Gentran Integration Suite requires the following parameter settings in your SQL Server database:

Parameter Value

Collation Setting SQL_Latinl_General_CP850_BIN

Sort order Binary

Security authentication SQL Server and Windows

Torn Page Detection Off

Parallelism Use one processor (do not use all available
processors)

SQL Server Database User Privileges

In SQL Server, you must grant DBO (Database Owner) permission to Gentran Integration Suite user. The
DB_DDLADMIN roleisrequired for creating objectsin the SQL Server database.

Configuring a SQL Server Database for a Production Environment

Y ou need to configure your SQL Server database for running in a production environment with Gentran
Integration Suite. To configure a SQL Server database for a production environment, you must:

4 Size the database by estimating the required disk space. For more information, refer to Database
Szing on page 7.

4+ Run the database scripts to create tables, indexes and so forth for the SQL Server database.
4 Set the database connection properties.
To run the scripts for the SQL Server database, do the following:

1. Make sure you have a sQL Server client installed on your computer.

Sterling Commerce, an IBM Company 14
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2. Run the CustomDBView script.
3. Examinethelog filesfor errors.

Installing the JDBC Driver in SQL Server

Gentran Integration Suite requires the correct Microsoft SQL Server driver. See System Requirements for
supported version information. The supported version of the JDBC driver builds the correct Gentran
Integration Suite directory structure.

Refer to one of the following sections for your Microsoft SQL Server version:

4+ Installing the JDBC Driver in SQL Server 2000 on page 15
4+ Installing the JDBC Driver in SQL Server 2005 on page 15

Installing the JDBC Driver in SQL Server 2000

Go to the Microsoft web site to download this driver, any appropriate patches, and the following .jar files.
Be sureto place all the .jar filesin the same directory.

4 msbhasejar
4+ mssglserver.jar
4+ mattil jar files

After you obtain the JIDBC driver fileand .jar files, record the absol ute path to their location on your system.
Y ou must supply this absolute path when you install Gentran Integration Suite. When you select these files
during the installation, you can use one of the following methods:

Note: Itisrecommended that you use the first method (select all three files), because the second method
(select acombined jar file) generates warning messages that might be confusing.

4+ Inthe browse window, select al three files by holding down the Ctrl key and clicking each file name.
4+ Inthe browse window, select a combined jar file, which you create using the following method:
a. Make anew directory in which you will work, and copy the separate jar filesto this directory.
b. For each of the separate jar files, issue the following command:
jar -xvf jar_file_nane

c. After al of the jars have been expanded, remove the META-INF directory that will be located in
the working directory.

d. Createanew jar file by issuing the following command:

jar -cvf conbi nedJarNane.jar *

Installing the JDBC Driver in SQL Server 2005

Go to the Microsoft web site to download the driver and any appropriate patches.
1. Download sgljdbc_version_language.exe to atemporary directory.

2. Runsgljdbc_version_language.exe.

3. When prompted, enter an installation directory to which you will unpack zip file that contains the
driver. It isrecommended that you unpack the zip filein your Program Files directory with the default
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directory Microsoft SQL Server 2005 JDBC Driver. You will access this directory path during the
installation of Gentran Integration Suite.

Note: Make sure that you specify the full path to the installation directory. For example, C:\Program
Files\Microsoft SQL Server 2005 JDBC Driver.

After the package unpacks, you can find out more information about using this driver by opening the
JDBC Help System in the absolutePath\sgljdbc_ver sion\language\help\default.htm file. Thiswill
display the help system in your Web browser.

4. When the Gentran Integration Suite installation asks for the location of the JDBC drivers, specify the
extracted jar file created after unpacking the archive (usually named sgljdbc.jar). The JDBC driver
version is the same as the version of the drivers downloaded from Microsoft.

Configuring Snapshot for Microsoft SQL Server 2005

The snapshot feature in Microsoft SQL Server 2005 allows you to view aread-only copy of the database
even when it islocked. It is recommended to configure snapshot feature as it reduces deadlocks. Run the
following command to enable snapshot feature:

ALTER DATABASE db_nanme SET READ _COWM TTED_SNAPSHOT ON;

Installing DB2

Y ou can use a DB2 database for maintaining information on Gentran Integration Suite. The following
sections provide the necessary steps to install and configure a DB2 database for production.

Toinstall DB2, do the following:
1. If youdo not have DB2 installed, follow the installation proceduresin your DB2 Installation manual.

Note: When creating the DB2 database, the appropriate codepage needs to be selected for international
language characters (for example, UTF-8).

2. Copy thejarsto awell-known location for reference during installation. The two jar files have to be
repackaged as onefile for the installer. Unzip the filesinto afolder and rezip them as one jar file.

Note: Various Gentran Integration Suite scripts, such as the one used for loading the factory defaults,
specify aDB_Driver. TheDB_Dri ver specified must include both of these JAR files.

3. You need to set the following parameter to avoid memory leaks and DB2 crashes:
db2set DB2_NUM CKPW DAEMONS=0

DB2 Database User Privileges
The DBADM roleisrequired for performing administrative operations in the DB2 database.

Configuring a DB2 Database for Production

Y ou need to configure your DB2 database for running in aproduction environment with Gentran Integration
Suite. To configure a DB2 database for a production environment, you must size the database by estimating
the required disk space. It is not recommended to use multiple schemasin a database. If necessary, you can
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create multiple databases (one per user) to prevent schema collisions. For more information, refer to
Database Szing on page 7.

Note: Theinstallation script creates tables and indexes. Certain tables require a page size of 16K. You
should have a tablespace to accommodate such tables. DB2 automatically places tables and indexes
in the availabl e tablespaces using itsinternal logic. You can movethetablesto adifferent tablespace
after the installation is compl ete.

Using a DB2 Database Server

Y ou can use a DB2 database with Gentran I ntegration Suite. See System Requirementsfor supported version
information. To use a DB2 server, follow this process:

4 Create the database. Refer to the DB2 documentation for information about creating the database,
including creating a schema repository, login, and tablespace. Be sure to install the correct version and
patch. Be sure to install the client components and compilers before you install the fixpack.

4+ Configure the database by completing the following tasks:
+ Installing Client Components, Compilers, and Fixpack on page 17
¢ Setting Parameters for DB2 on page 17
¢ Granting Permissions for DB2 on page 18
¢ Installing JDBC Driversfor DB2 on page 18

Installing Client Components, Compilers, and Fixpack

Gentran Integration Suite uses stored procedures for DB2. Y ou must install or set up the following
components:

1. Install the Administration client.
2. Install Gentran Integration Suite Development clients.

3. Install the necessary fix pack after you install the client components and compilers. Otherwise, the
clientswill overwrite the fix pack binaries.

4. Set the path for the compiler by using the db2set command.

For more information about these tasks, see the IBM documentation.

Setting Parameters for DB2
The following parameter settings are required in your DB2 database:

Parameter Value

APPLHEAPSZ greater than or equal to 10000
APP_CTL_HEAP_SZ greater than or equal to 512
MAXAPPLS greater than or equal to 150
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Parameter Value

LOCKLIST greater than or equal to 30000
MAXLOCKS 100

Database code page UTF-8

Granting Permissions for DB2

Grant DBADM permissions to the user.

Installing JDBC Drivers for DB2

For DB2, ingtall the appropriate DB2 JDBC Type 4 driver and any correlating patches. See System
Requirements for supported version information.

Y ou can obtain these files from the IBM Web site. After you obtain this JDBC driver, record the absolute
path to itslocation on your system. Y ou must supply this absolute path during installation.

If the IDBC driver provided by your database vendor is distributed among multiplefiles, you must place al
the files that comprise the JIDBC driver into one .jar file. Follow these stepsto create one .jar file:

1. Identify all the vendor database jar files for the JDBC driver.
2. Create atemporary working directory (mkdir wd; cd wd).

3. Extract the contents of each file used for the JIDBC driver using the jar utility into the temporary
working directory (j ar -xf \path\to\db2jcc.jar andjar -xf
\path\to\db2jcc_license.jar).

4. Bundlethefilesin the temporary working directory into onefile using the jar utility (j ar - cf
\path\to\new db2_all.jar *).

5. Record the absolute path to the .jar file you created on the Preinstallation Checklist.

The Type 4 driver does not require a separate Java listener running on the database server. Instead, connect
directly to the DB2 port.

Using a MySQL Database Server (Non-Clustered Only)

Note: Only Windows non-clustered installations of Gentran Integration Suite can use the MySQL
database.

Y ou can chooseto use the MySQL database server that isbundled with Gentran I ntegration Suite. Choosing
this database during theinstallation procedure creates and configuresit for you. MySQL isinstalled locally
on the same server as Gentran Integration Suite and cannot be installed on a separate server.
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Managing Database Passwords

A password is used by the application to connect to its database. The password is stored as clear text in a
property file on the system. If the security policiesat your company require you to encrypt these passwords,
you can do so after you install Gentran Integration Suite. Encrypting these passwords is optional .

Database Password Encryption Methods

Database passwords are encrypted using one of two methods, OBSCURED or ENCRY PTED. The
encryption method is decided by the value of the encryptionPrefix in propertyEncryption.properties or
propertyEncryption.properties_platform_security_ext file.

Encrypting Database Passwords (Windows)

To encrypt the database password:

Stop the Gentran Integration Suite.
Navigate to \install_dir\install\bin.
Enter enccfgs. cmd.

Enter setup. cmd.

Enter deployer.cmd.
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Enter startWindowsService.cmd to start the Gentran Integration Suite.

Decrypting Database Passwords (Windows)

To decrypt a password in Windows:

Stop the Gentran Integration Suite.

N

Navigate to \install_dir\install\properties.
Open the sandbox.cfg file.

Copy encrypted password from the database PASS property. Use the text that appears after the
database PASS= text. For example, if database PASS= OBSCURED:123ABCxyz321, you would
copy the text OBSCURED: 123ABCxyz321. (OBSCURED is the encryption method for the
password.)

Navigate to \install_dir\install\bin.

Enter decrypt_string.cmd encrypted_password. For encrypted_password, use the text that you
copiedin Step 4.

> w

Y ou are prompted for the Sterling Integrator passphrase.
Y our decrypted password appears.
7. Navigateto\install_dir\install\properties.
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8. Edit the sandbox.cfg file to replace the encrypted password with the password that was returned in
Step 6.

9. You need to decrypt the entry for YANTRA_DB_PASS. Repeat Steps 4 to 8 to decrypt
YANTRA_DB_PASS.

Note: You should aso decrypt any custom database pool passwords present in the
customer_overrides.propertiesfile or any other propertiesfile.

10. Navigate to\install_dir\install\bin.

11. Enter setupfiles.cmd.

12. Enter deployer. cmd.

13. Enter startWindowsService.cmd to start the Gentran Integration Suite.
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Chapter 3

Installing in a Non-Clustered Windows
Environment

Caution: Gentran Integration Suite should be installed behind a company firewall for security purposes.
See the Perimeter Server and Security topics in the Gentran Integration Suite documentation
library for more information on secure deployment options.

Preinstallation Setup Checklist for a Non-Clustered Windows
Environment

The following topics will assist you with preinstallation tasks when planning to install Gentran Integration
Suite in a non-clustered Windows environment:

Checklist for Windows Preinstallation on page 21
Checking System Requirements on page 24

Installing the Java 2 Software Devel opment Kit on page 24
Downloading the JCE Distribution File on page 25
Determining Port Numbers on page 25

Obtaining a License File on page 26

Slent Installations on page 27

Installing the JDBC Driver in SQL Server on page 27

Checklist for Windows Preinstallation

The preinstallation checklist for the Windows environment identifies the prerequisite tasks you must
complete before installing Gentran Integration Suite.

Note: When creating aname, such asan account name, permissions name, profile name, or database name,
follow these conventions:

¢ Useany valid aphanumeric charactersand -, :, $, &, or _.
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+ Do not use spaces or apostrophes.

Y ou may want to make acopy of the following checklist and useit to record the information you collect for
installing Gentran Integration Suite:

Step Description Your Notes

1 Verify that your system meets the hardware and software
requirements specified for this release. See Checking
System Requirements on page 24.

2 Verify that your system has the patches required by
Java™ for the Windows environment. See the vendor’s
Java Web site for more information.

3 For systems with multiple IP addresses, verify that the IP
address on which Gentran Integration Suite resides is
accessible by any client computer that is running a
browser interface.

Caution: If you do not verify the IP addresses, your
system may not operate properly after installing Gentran
Integration Suite.

4 Verify that all client computers are using Microsoft
Internet Explorer 5.x or later.

5 If you are using a non-English environment, confirm that
you are using the appropriate character set.

6 Determine and record information about the Java 2
Software Development Kit (JDK). See Installing the Java
2 Software Development Kit on page 24.

¢ Version of the JDK.

¢ Absolute path to the JDK files and patches. The path
name cannot include spaces.

7 Obtain the JCE distribution file and record the absolute
path to the zipped file. See Downloading the JCE
Distribution File on page 25.

8 Determine and record the initial port number to be used
by Gentran Integration Suite. See Determining Port
Numbers on page 25.

Sterling Commerce, an IBM Company 22



Preinstallation Setup Checklist for a Non-Clustered Windows Environment

Step

Description Your Notes

If you are using a SQL Server 2000/2005 database or an
Oracle database, determine and record information
about your database server. Be aware that this
information is case sensitive.

¢ Database vendor

¢ Database user name and associated password
¢ Database (catalog) name

¢ Database host name

¢ Database host port number

¢ Absolute path and file name for the JDBC driver

¢ \ersion of the JDBC driver

10

Determine and record information to set up default
system alerts from Gentran Integration Suite:

¢  The Administrative e-mail address to which system
alert messages are sent.

¢ The SMTP Server IP address used for sending alert
messages.

11

Determine and record the directory in which you plan to
install Gentran Integration Suite.

¢ The installation directory must not exist because the
installation process creates it.

¢ The installation directory must have adequate free
disk space.

¢ The name of the directory cannot include spaces and
must be less than 30 characters long excluding
separators, for example, C:\GIS_43\install_dir\install.
Using a directory name of more than 30 characters
could create an installation that is impossible to
delete.

12

Determine and record the passphrase you want to use
for Gentran Integration Suite system.

During installation, you must enter the passphrase twice.

13

Obtain the license file and record the absolute path and
file name to the license file. Be sure that the path name
and the file name do not contain any spaces. See
Obtaining a License File on page 26.
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Step Description Your Notes
14 Determine whether Gentran Integration Suite is using an

application server (JBoss™, WebLogic® or

WebSphere®).

Gentran Integration Suite does not require an application
server for installation or at runtime.

Gentran Integration Suite supports integration with JBoss
and WebLogic during the installation. You can also
integrate with WebSphere, JBoss, or WebLogic after
installing version 4.3 by using the Gentran Integration
Suite EJB Adapter. This does not represent a WebLogic
server for deploying the Application Console.

Checking System Requirements

Before you begin, verify that your system meets the hardware and software reguirements specified for this
release. The hardware requirements listed are the minimum required to run Gentran I ntegration Suite. Y our
system requirementswill exceed theseif you are running other applications on the same machine as Gentran
Integration Suite. For current information, see the System Requirements posted on Gentran I ntegration Suite
Documentation Library:

http://www.sterlingcommerce.com/Documentati on/Gl S43/homepage.htm

Theinstallation strictly enforces the following system requirements:

Operating system version (must match requirement exactly)

The minimum patch level for the operating system is enforced, but you can apply higher patch levels.
JDK version (must match requirement exactly)

Disk space

The disk spaceisaminimum for the installation. The system should be separately sized to handle
whatever load is going to be put on the system.

Installing the Java 2 Software Development Kit

You must install the Java 2 Software Development Kit (JDK) and the patches specific to your system. To
determine which JDK version and patches you need, see the System Requirements. After you install the
JDK, record the path to the JDK for future reference.

Caution: Two registry keyswritten by the installation of the Sun JDK version 1.5.0-11 are faulty and
includeaninvalid valuefor the JavaHome key (the JavaJDK location). If the Gentran Integration
Suiteinstallation cannot find the Java JDK location using the registry settings, you are prompted
for the location of the Java JDK directory. Once the installation is complete, the registry will be
updated with the correct JDK location.
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Downloading the JCE Distribution File

The Java Cryptography Extension (JCE) isaset of Javapackagesfrom Sun Microsystems, Inc. that provides
aframework and implementations for encryption, key generation and key agreement, and Message
Authentication Code (MAC) agorithms.

Note: If you areinstalling Gentran Integration Suite outside of the United States, check to seeif you can
get the JCE unlimited strength jurisdiction policy files. The unlimited strength jurisdiction policy
files can only be exported to countries to which the United States permits the export of higher-level
encryption.

To obtain thisfile for the Sun JDK 1.5:
1. Open your browser and navigate to http://java.sun.com/javase/downl oads/index_jdk5.jsp.

2. At the bottom of the page, locate Java Cryptography Extension (JCE) Unlimited Srength Jurisdiction
Policy Files 5.0 and click the Download button.

3. Download thejce policy-1 5 0.zipfileto your system.

Once thefileresides on your system, note the exact directory and file name for this zipped file. You
will need this information during the installation process.

Determining Port Numbers

During installation, you are prompted to specify theinitial port number for Gentran Integration Suite. For
other ports, you can accept the default port number suggested by the install ation program, or you can specify
adifferent port number. To specify a port number, follow these guidelines:

Gentran Integration Suite requires arange of 100 consecutive open ports between 1025 and 65535.
Theinitial port number represents the beginning port number in the range.

The port range starts with theinitial port number and ends with the number that equals the initial port
number plus 100. All portsin this range must be available for Gentran Integration Suite. For example,
if you specify 10100, then you need to make sure that 10100 through 10199 are not used by any other
applications on your system.

All port assignments can be found in the install_dir\properties\sandbox.cfg.

HTTP portsare assigned in pairsto facilitate an HTTPS listener on the second port. Thefollowing portsare
assigned:

B2B_HTTP_PORT= baseport+6 and baseport+7

WEBX_PORT= baseport+8 and baseport+9

SOAP_PORT= baseport+10 and baseport+11

Two ports (HTTP_SERVER_PORT and LIST_PORT) are required to access Sterling Secure Proxy from
browsers. If you plan to configure Sterling Secure Proxy from a higher security network, you need both of
these ports open in your firewall.
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Obtaining a License File

After your company signed the sales contract with Sterling Commerce, Sterling Commerce created alicense
file containing information about your company, your system, and the packages (components), such as
services, maps, and adapters, your company selected to use.

Thelicensefile contains alicense that is associated with your specific operating system and the | P address
of your system. The license provides access, for 20 yearsfrom the date of issue, to Gentran Integration Suite
packages your company selected and is independent of your maintenance fee. Because thelicenseis
independent of your maintenance fee, the schedule for renewing your license and license file may be
different than the maintenance fee schedule.

Y ou must download the license file before you can install Gentran Integration Suite. Follow these steps:

1. Point your Web browser to http://www.productupdates.stercomm.com.

2. Review the Welcome to Sterling Commerce Product Update page and click Next.
3. Review the Authenticate page and click Next.
4

Typethe License File Key, which is case-sensitive, and click Next. If the system displays the Retrieve
Registration dialog box and you are upgrading, you may retrieve your registration information by
entering your previous License File Key. If you are not upgrading, then click Next.

vl

Verify the registration information and click Next.
On the Server Details page, update the fields and click Next.

If the operating system, application server, or database server version is not listed in the respective
lists, type the version in the respective Description of Other.

All 1P addresses assigned to the server in which you are installing Gentran Integration Suite should be
listed in the licensefile.

7. Verify thelist of packages and the type of license selected for each package and click Next. If the list
of packages selected or the type of license selected is not correct, then contact Customer Support to
correct the information.

8. Scrall to the bottom of the Review and Download Package License File page and click Finish and
Download.

9. Click Savein the File Download dialog box.

10. Accept the default location for the license file or navigate to the location where you will store the
license file. Note the absolute path of the file location on the Preinstallation Checklist. You will need
the absolute path to install Gentran Integration Suite.

11. Click Save.
12. Close your Web browser.
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Silent Installations

Y ou can set up aninstallation of Gentran Integration Suite so that it runs with no user interaction. For these
silent installations, you need to create the following items for your installation script:

A text file with information that during an interactive installation you are prompted to enter. This
information is then automatically accessed by the installation script.

Examples of silent installation text file entries:

APSERVER PASS = (system passphrase)

INSTALL DIR = (full path to the installation directory)

LI CENSE_FI LE PATH = (full path to the license file)

PORT1 = (initial port)

JCE DIST FILE = (full path to the JCE distribution file)

SI _ADM N_MAI L_ADDR = (enmil address for adnministrative contact)
SI _ADM N_SMIP_HOST = (SMIP nai |l server host nane)

DB _VENDOR = (database - [ MSSQL| M5SQL2005| O acl e)

ACCEPT_LI CENSE = (license agreenent acceptance - [yes/no])

DB USER = (dat abase user 1D)

DB _PASS = (dat abase password)

DB _DATA = ('net service nane' or 'database nane')
DB HOST = (database hostnanme or |P address)

DB PORT = (database's |istener port.)

DB DRIVERS = (fully qualified path to the database driver)
DB DRI VERS _VERSI ON = (version of database drivers)
A referencein your installation script to this variablefile.

Windows silent installation files must delimit al colons (:) and backslashes (\) with a backslash. For
example, | NSTALL_DI R=C\:\\ pat h\\for\\install directory

Also, Windows silent installation files must use the - noi nst al | shi el d argument in the command.
Example:

install _dir\\JDK\\bin\\java -jar G Sxx.jar -f silent_install _file
-noinstal I shield

Installing the JDBC Driver in SQL Server

Gentran Integration Suite requires the correct Microsoft SQL Server driver. See System Requirements for
supported version information. The supported version of the JDBC driver builds the correct Gentran
Integration Suite directory structure.

Refer to one of the following sections for your Microsoft SQL Server version:

Installing the JDBC Driver in SQL Server 2000 on page 28
Installing the JDBC Driver in SQL Server 2005 on page 28
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Installing the JDBC Driver in SQL Server 2000

Go to the Microsoft web site to download this driver, any appropriate patches, and the following .jar files.
Be sureto place al the .jar filesin the same directory.

msbase.jar
mssqgl server.jar
msultil.jar files

After you obtainthe JIDBC driver fileand .jar files, record the absol ute path to their location on your system.
Y ou must supply this absolute path when you install Gentran Integration Suite. When you select thesefiles
during the installation, you can use one of the following methods:

Note: Itisrecommended that you use the first method (select all three files), because the second method
(select acombined jar file) generates warning messages that might be confusing.

In the browse window, select al three files by holding down the Ctrl key and clicking each file name.
In the browse window, select a combined jar file, which you create using the following method:
a. Make anew directory in which you will work, and copy the separate jar filesto this directory.
b. For each of the separate jar files, issue the following command:
jar -xvf jar_file_nane

c. After all of the jars have been expanded, remove the META-INF directory that will be located in
the working directory.

d. Createanew jar file by issuing the following command:

jar -cvf conbi nedJar Nane.jar *

Installing the JDBC Driver in SQL Server 2005

Go to the Microsoft web site to download the driver and any appropriate patches.
1. Download sgljdbc_version_language.exe to atemporary directory.

2. Run gsgljdbc_version_language.exe.

3. When prompted, enter an installation directory to which you will unpack zip file that contains the
driver. It isrecommended that you unpack the zip filein your Program Files directory with the default
directory Microsoft SQL Server 2005 JDBC Driver. You will access this directory path during the
installation of Gentran Integration Suite.

Note: Make sure that you specify the full path to the installation directory. For example, C:\Program
Files\Microsoft SQL Server 2005 JDBC Driver.

After the package unpacks, you can find out more information about using this driver by opening the
JDBC Help System in the absolutePath\sgljdbc_version\language\hel p\default.htm file. Thiswill
display the help system in your Web browser.

4. When the Gentran Integration Suite installation asks for the location of the JDBC drivers, specify the
extracted jar file created after unpacking the archive (usually named sgljdbc.jar). The JDBC driver
version is the same as the version of the drivers downloaded from Microsoft.
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Installing in a Non-Clustered Windows Environment

Note: The following instructions assume that you received an installation CD for Gentran Integration

Suite. If you downloaded Gentran Integration Suite or a Service Pack (SP) from the Electronic
Software Distribution (ESD) Portal, unzip the downloaded file to an empty directory. Do not change
the directory structure of the newly unzipped files. The directory containing the unzipped filesisan
electronic image of an installation CD. Use this directory wherever there is areference to the
installation CD in the following instructions. Ignore any instructions to place the installation CD in
adrive.

Toinstall Gentran Integration Suite in a non-clustered Windows environment, refer to your preinstallation
checklist and follow the steps below.

Note: Toinstall more than oneinstance of Gentran Integration Suite on the same Windows server, you
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must install the second instance in a different directory and use a different initial port number. This
second port number must be at least 100 higher or lower than the first port number.

During the installation, various messages are displayed, including some warning messages. These
warning messages require no action on your part and are included so that helpful datais recorded in
thelogfile.

Close al open Windows programs and any command prompt windows.
Insert Gentran Integration Suite installation CD in the appropriate drive.
On theinstallation CD, navigate to the windows\install folder.
Double-click setup.exe. Then click Next to start the installation program.
Review the license agreement, and click Yes to accept the terms.

Theinstallation program searches for the JDK, using the registry settings. If the program cannot find
the JDK location using the registry settings, you are prompted for the location of the JDK directory.
Use the Browse button to search for the directory. For more information, refer to the caution
information in Installing the Java 2 Software Development Kit on page 24.

Click Next.

You are prompted to choose an installation directory for Gentran Integration Suite. Click Browse and
navigate to the folder you want to use as the installation directory. This directory is referred to as
install_dir in subsequent prompts.

Note: The name of the directory cannot include spaces and must be less than 30 characters long
excluding separators, for example, C\GIS_43\install_dir\install. Using a directory name of more than
30 characters could create an installation that isimpossible to delete.

You are prompted to browse to the location of the license file. Select the license file, and click Next.

If you have not installed alicense file, you can minimize this window, obtain the licensefile, and then
return to the installation process.

You are prompted to browse to the location of the JCE distribution file. Select the JCE distribution file,
and click Next. The program verifies the path name.

10. A screen appears with the following four checkboxes:
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14.

15.
16.
17.

18.

Installing in a Non-Clustered Windows Environment

¢ | want toinstall a cluster node 2 or higher

This option is not used for non-clustered installations.
¢ | want toupgradefrom aprior version

Select this checkbox only when upgrading from a prior version of Gentran Integration Suite.
¢ | want to enable FIPS mode

Select this checkbox if you are enabling the Federal Information Processing Standards (FIPS)
mode.

¢ | want GISto automatically create the database schema

This checkbox is selected by default. Make sure that it is selected, as the option of manually
creating the database schema is not supported on the Windows environment.

After choosing your checkbox option, click Next

The system displays a command window. Leave the command window open. You can minimize the
command window, but do not closeit or the install ation program cannot prompt you for information or

display status messages.
The system displays a message window listing information you will need in subsequent steps. Click
OK to continue.

You are prompted about overriding the host | P address for this installation.
* To accept the default host | P address, click Next.
* To specify another host | P address, enter the I P address you want to use. Click Next.

Note: If you areinstalling Gentran Integration Suite on VMware, you should provide the | P address of
the virtual machine and not of the VMware host. For example, if 10.251.124.160 is the | P address of
the VMware server and 10.251.124.156 is the | P address of the Windows 2003 server it is hosting, you
should use 10.251.124.160 as the | P address to install Gentran Integration Suite.

Type the administrative e-mail address to which you want system alert messages to be sent. Click
Next.

Type the SMTP mail server host name that you want to use for alert messages. Click Next.
Type your system passphrase in both the Passphrase box and the Confirm box. Click Next.
Typetheinitial port number for Gentran Integration Suite server and click Next.

Theinstallation creates subsequent ports based on the initial port number. These port assignments are
writtento install_dir\ pr operti es\ sandbox. cf g.

Select the database you want to use and click Next.
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+ If you select Microsoft SQL Server 2000 or 2005, enter the following information and click Next:
* Database host name
* Database host port number
* Database name
e User ID
* Password
* Password confirmation

+ |f you select Oracle, you are asked whether the Oracle instance is being used for an upgrade.
Answer No.

Enter the following information and click Next:
* Database host name

* Database host port number

* Database name

e User ID

* Password

* Password confirmation

19. If you selected Oracle or either version of Microsoft SQL Server asyour database, verify that you have
the required JDBC driversinstalled.

a. Veify that you have the required JDBC driver file copied to alocal folder on your computer. Use a
descriptive name for this folder that will help you later access the driver.

b. Browseto the location of the JDBC driver file. Select the file and click Open. For more
information about how to select the file for Microsoft SQL Server, refer to Installing the JDBC
Driver in SQL Server on page 27.

c. IntheVersion Number field, type x_x and click Next. Refer to System Requirements for the
actual version number.

20. Click Yesto proceed with the installation.

21. Theinstallation completes automatically. When the installation is finished, the system places an icon
on your Windows desktop and displays a message that Gentran Integration Suite was successfully
installed. Click OK. Click Next. Click Finish.

If you encounter problems or errors during installation, see the section Troubleshooting: Windows
Environment.

Patches and Hot-Fixes (Non-Cluster)

The following sections explain how to update Gentran Integration Suite, using the following methods:
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Installing the Current Maintenance Patch (Non-Cluster) on page 32

Patches contain cumulative fixes for a specific version of Gentran Integration Suite. Because each
patch contains the fixes from previous patches, you only need to install the most recent patch.

Installing a Hot-Fix (Non-Cluster) on page 34
A hot-fix is one or more fixes applied to a specific existing patch.

Installing the Current Maintenance Patch (Non-Cluster)

Patches contain cumulative fixes for a specific version of Gentran Integration Suite. Because each patch
contains the fixes from previous patches, you only need to install the most recent patch.

Note: During patch installation, the dbVerify utility compares the list of standard indexes with those
present in the database and drops the custom indexes. You should recreate the custom indexes after
the patch installation is complete.

To help you determine which patch to use, the files are named using the following naming convention:
si_43 build_build number.jar (for example, si_43 build_4307.jar)

Information about apatch islocated in a PDF file with asimilar name. The naming convention for PDF files
containing information about a particular patch is:

si_43 build build number_patch_info.pdf (for example, si_43 build 4307_patch_info.pdf)

Both the .jar and the .pdf files are available on the Sterling Commerce Support on Demand Web site, at
https://support.sterlingcommerce.com. Y ou should periodically check the web site to verify that you have
the most recent patch.

Note: The patch installation may use one or more patch property override files. These fileswill be named
propertyFile patch.properties. Do not alter thesefiles.

Additionally, property changes made directly in .properties or .properties.in files may be
overwritten during the patch installation. Properties overridden using the
customer_overrides.properties file are not affected.

Toinstall thelatest patch for Gentran Integration Suitein anon-clustered Windows environment, follow the
steps below:

1. Go to the Sterling Commerce Support on Demand Web site, at https.//support.sterlingcommerce.com.

2. Download the most recent patch file for your version of Gentran Integration Suite and record the
absolute path to the downloaded file. If you use FTP, use Binary mode. Do not rename the file. Make
sure that you download the file to your local machine (for example, to your installation bin directory),
and not to a network drive. Use the full path to your local machine when you install the patch.

3. If you are using a database other than MySQL, verify that the database server is up and ready to accept
connections.

Stop Gentran Integration Suite.

5. Perform afull backup of Gentran Integration Suite installation directory, including all subdirectories.
Also back up your database.

Sterling Commerce, an IBM Company 32



Patches and Hot-Fixes (Non-Cluster)

6. If your database password is encrypted, decrypt the password. For more information about decrypting
database password, refer Decrypting Database Passwords (Windows) on page 19.

7. 1f you edited any property files, update the customer_overrides.properties file with these changes. This
will keep the edited property files from being overwritten with the contents of the associated
initialization (*.properties.in) files during the patch installation. Please refer to the documentation on
configuring overrides to propertiesfiles.

Close al command prompt windows.
Install the patch using the following commands:
a.  Open acommand prompt window.

b. Change to the directory where Gentran Integration Suite isinstalled and run the following
command:

instal I Dir\bin
c. Runthefollowing command to install the patch:

I nstal |l Service. cnd
<pat h>\'si _<version>_sp 0 patch_<nunber>_<app_server>.jar

where:

<path> = Fully qualified path to maintenance patch file
<version> = Gentran Integration Suite Version
<number> = Patch number

<app_server> = Application Server

Example: I nstal | Service.cnd c:\patch\si_22 sp 0 patch_1_jboss.jar
Information about the patch installation is automatically logged to install_dir/logs/Install Service.log.

If the patch attempts to modify the database schema and the modification fails, you will receive an
error message about the failure. The message provides the error message code from the database and
the SQL command that failed. The failure information is also logged to the system.log file and to the
patch.log file.

10. If you decrypted the database password, re-encrypt the password. For more information about
encrypting database password, refer Encrypting Database Passwords (Windows) on page 19.

11. Restart Gentran Integration Suite.

If you are using a perimeter server inaDMZ, see Installing Patchesin a Perimeter Server Non-Clustered
Windows Environment on page 40.

Running a DB2 Schema Change Script

After youinstall Gentran Integration Suite, Release 4.3 build 4316 or later, runthef i x_db2_schena. sql
script. If you areusing DB2 asaremote host for Gentran Integration Suite, runningf i x_db2_schena. sql
script applies new schema changes and fixes SQL exception error that may occur during large file transfers.

Torunfix_db2_schema. sql script:
1. Install Gentran Integration Suite, Release 4.3 build 4316 or later.
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2. Apply the new schema changes by running f i x_db2_schema. sql script.

cd <install _dir>\bin db_execFile.cnd —i
<install _dir>\bin\sgl\fix _db2 schena.sql -0 <output file> -j -s -p

The script will:
¢ Rename the affected tables and indexes
¢ Recreate the affected tables and indexes with the correct datatypes.
+ Migrate the data from the renamed tables to the recreated tables.
3. After verifying the changes, run drop statements to drop the old tables.

The old tables can remain in the system, but occupies additional database space. The
fi x_db2_schema. sql script contains commented statements to drop the affected tables. It is
recommended to run these statements manually after verifying that data was migrated successfully.

Installing a Hot-Fix (Non-Cluster)

After you install or upgrade Gentran Integration Suite, you may need to install ahot-fix. A hot-fix isone or
more fixes applied to a specific existing patch.

Before Installing a Hot-Fix
Before you can install a hot-fix developed for your company, you must have completed the following:
Received the case ID number from Sterling Commerce Customer Support

Created afull backup of Gentran Integration Suite
Created afull backup of your database

Hot-Fix Installation
To install a hot-fix on the Windows host system:

1. Isthe password encrypted? If Yes, decrypt the password. For more information about decrypting
database password, refer Decrypting Database Passwords (Windows) on page 19.

2. Open acommand line session. Click the Windows Start menu and select Programs > Accessories >
Command Prompt.

3. Atthecommandline typeftp theworl d. stercomm com

Type your user name and password. If you do not know your user name and password, contact Sterling
Commerce Customer Support.

Type bi n and press Enter to select Binary as your transfer mode.

At the FTP prompt, typeget ccasei d. j ar, where caseid isthe ID you received from Customer
Support.

Shut down Gentran Integration Suite.
Open a command prompt and change the directory to install_dir\bin.
Typelnstal | Service path to ccaseid.jar\ccaseid.jar toinstall the hot-fix.
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If you decrypted the password in step 1, re-encrypt the password. For more information about
encrypting database password, refer Encrypting Database Passwords (Windows) on page 19.

In the command prompt, change the directory to install_dir\bin.

Typeuni nst al | W ndowsSer vi ce. cnd and log off. This removes previous Gentran Integration
Suite Windows services from the Windows cache.

At the command prompt, type your user name and password.

Change the directory to install_dir\bin.

Typei nst al | W ndowsSer vi ce. cnd to install Gentran Integration Suite Windows services.
Restart Gentran Integration Suite.

Intheinstall_dir\bin directory, run dunp_i nf o. cnu to verify that the hot-fix was successfully
installed. The successful running of dunp_i nf o. cnd will display the Gentran Integration Suite
version number.

Hot-Fix Package Delivery Method

The hot-fix package delivery method has changed effective Gentran Integration Suite, Release 4.3 Build
4324 onwards. The hot-fix package will be delivered asajar file that contains only the files that were
modified. However, the installation procedure for ahot-fix remains the same. Refer to Hot-Fix Installation
on page 34 for hot-fix installation procedure.

Thefollowing list describes the features of the new hot-fix package model:

Modified components are packaged as an installable file (jar).
Hot-fix version is maintained in the hotfix.propertiesfile. It does not update the SI_ VERSION table.

Run dunpi nf 0. cnd command to display the hot-fix version. You can also verify the hot-fix version
in Gentran Integration Suite Support user interface page.

Size of the hot-fix package is small.

Hot-fix must be installed on the same build version that was used to build it. For example, if atest
system is on Gentran Integration Suite, Release 4.3 Build 4324 and the hot-fix is built for 4324, it can
beinstalled on that test system. However, if the production system is on Gentran Integration Suite,
Release 4.3 Build 4323, you must apply Gentran Integration Suite, Release 4.3 Build 4324 prior to
applying the hot-fix.

You can locate the hot-fix read me file in the Gentran Integration Suite root (install_dir) directory. For
example, install_dir\hotfix_readme.txt.

If you have Sterling File Gateway installed in your environment, the hot-fix for Sterling File Gateway
isinstalled automatically.

Performing Checksum using DB Checksum Tool

A checksum is asimple redundancy check used to detect errorsin data. In Gentran Integration Suite 4.3, a
verification processis used to compare the checksum between the existing default resource and the resource
added after applying a patch or upgrading. The DB Checksum tool, a resource difference tool generates a
granular report of the changes in the system that was not permitted to be set as defaults.
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The DB Checksum tool generates the difference in resource checksum between the default resource and the
latest system resource from the database.

To run DB Checksum tool, do the following:

1
2.

Navigate to the<i nst al | _di r>\ bi n directory.
Run the following command from the <i nst al | _di r >\ bi n directory:

db_checksumtool.cnd [-d] [-i [1] 2| 3] 4| 5]] [-r [wid | nap | schema |
sii | tenplate]] [-0 <output file>] [-g] [-h]

where:

- d isthe mode to dump the difference of resource checksum between the default resource and latest
system resource.

- i istheresource type integer (optional).
1isWFD
2 isMAP
3 isSCHEMA
4 isSll
5isTEMPLATE
-r istheresource name (optional).For example, wfd, map, schema, sii, or template.
- o isthefile name to output all the messages (optional).
- g isthefile name that lists all the ignored resources (optional).
- h isthe help screen.

The DB Checksum tool performs the relevant checksum operation based on the command options and
generates the output message.

Installing a Perimeter Server in a Non-Clustered Windows
Environment

Installing a Gentran Integration Suite perimeter server in a non-clustered Windows environment includes
the following tasks:

Setting Up Perimeter Serverswith Gentran Integration Suite on page 37

Installing a Perimeter Server in a More Secure Network (Windows Non-Clustered ) on page 37
Installing a Perimeter Server in a Less Secure Network (Windows Non-Clustered) on page 38
Installing Patchesin a Perimeter Server Non-Clustered WWindows Environment on page 40
Sarting and Sopping Perimeter Serversin Windows on page 41

Reducing Perimeter Server Security Vulnerabilities on page 41
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Setting Up Perimeter Servers with Gentran Integration Suite

Using a perimeter server with Gentran Integration Suite is optional.

A perimeter server is a software tool for communications management that isinstalledinaDMZ. The
perimeter server manages the communications flow between outer layers of your network and TCP-based
transport adapters. A perimeter server can solve problems with network congestion, security, and
scalability, especially in high-volume, Internet-gateway environments. A perimeter server requires a
corresponding perimeter client.

Gentran Integration Suite installation program installs a perimeter client and alocal mode server. Theloca
mode server isuseful for testing purposes or in environmentsthat do not require asecure solution. However,
if you require high-volume, secure connections, you must install aperimeter server in aremote zone, either
amore secure or less secure network than your integration server.

When you install a perimeter server, use these guidelines:

Licensing for a perimeter server is determined by the licensing restrictions on the corresponding B2B
adapters in Gentran Integration Suite.

Each perimeter server islimited to two TCP/IP addresses: internal interface and external interface.
Internal interfaceisthe TCP/IP address that the perimeter server uses to communicate with Gentran
Integration Suite. External interfaceis the TCP/IP address that the perimeter server uses to
communicate with trading partners.

To use additional TCP/IP addresses, install additional perimeter servers.

You may have multiple perimeter serversinstalled on the same computer interacting with one instance
of Gentran Integration Suite. To install a perimeter server on a computer with an existing instance,
install the new perimeter server in adifferent installation directory.

The combination of internal TCP/IP address and port must be unique for all perimeter serversinstalled
on one computer.

+ |If aperimeter server isinstalled using the wildcard address, then al ports must be unique.

+ |f aperimeter server isinstalled using the wildcard address, then its port is not available for use by
adapters that use the server or any other perimeter server on that computer.

¢ Theinternal and external interface may use the same TCP/IP address. However, the port used by
the perimeter server is not available to the adapters that use the server.

Installing a Perimeter Server in a More Secure Network (Windows
Non-Clustered )

Toinstall a perimeter server in a Windows non-clustered environment:

1. Closeal open Windows programs.

2. Insert Gentran Integration Suite installation CD into the appropriate drive.
3. Open aDOS command window.
4

Copy the ps_2000.jar installation files from the installation CD to your home directory or base
directory. If you are using FTP to copy thefile, be sure your session is set to binary mode.
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To begin the installation, enter the absolute path to the following jar file:
absol utePath\ bin\java -jar install _dir\packages\ps_2000.jar

The program verifies the operating system and required patch level and the location and version of the
JDK.

Enter the name for the installation directory.

If thereis an existing installation in the directory you specify, you can update it using the same
settings.

At the prompt Thereis an existing install at that location, update it while keeping existing settings?, if
you type yes and press Enter, the installation will proceed without additional entries.

Note: If you want to change any of the settings, you must use a new directory, or delete the old
installation before performing the new installation. You cannot overwrite an existing installation, and
you cannot use an existing directory that does not contain avalid installation. The existing installation
must be Gentran Integration Suite 4.3 or later.

The program verifies the amount of available disk space.

At the prompt Is this server in a less secure network than the integration server?, type No and press
Enter.

For more information about making the perimeter more secure, refer to Reducing Perimeter Server
Security Vulnerabilities on page 41.

At the prompt WiI this server need to operate on specific network interfaces?, if you type yes and
press Enter, the program returns alist of the available network interfaces available on your host.
Select the interfaces for the server to use.

Enter the TCP/IP address or DNS name that the integration server (Gentran Integration Suite) will
listen on for the connection from this server.

Verify the TCP/IP address or DNS name.

Enter the port that the intergration server (Gentran Integration Suite) will listen on for the connection
from this server. The port number must be higher than 1024.

Enter the local port that the perimeter server will use for the connection to the integration server
(Gentran Integration Suite). The port number must be higher than 1024, except specify aport of zero if
you want the operating system to select any unused port.

Verify the port.

When the perimeter server isinstalled, the following message is displayed:
Installation of Perimeter Serviceis finished

Change to the installation directory.

Enter i nst al | PS. cnd to install this perimeter server as aWindows Service.
Enter st ar t PSSer vi ce. cnd to start the perimeter server.

Installing a Perimeter Server in a Less Secure Network (Windows
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Non-Clustered)

Toinstall a perimeter server in a Windows non-clustered environment:

1

2.
3.
4

10.

11.
12.

13.
14.

15.

16.

Close al open Windows programs.
Insert Gentran Integration Suite installation CD into the appropriate drive.
Open a DOS command window.

Copy the ps_2000.jar installation files from the installation CD to your home directory or base
directory. If you are using FTP to copy thefile, be sure your session is set to binary mode.

To begin the installation, enter the absolute path to the following jar file:
absol utePat h\ bi n\java -jar install _dir\packages\ps_2000.j ar

The program verifies the operating system and required patch level and the location and version of the
JDK.

Enter the name for the installation directory.

If thereis an existing installation in the directory you specify, you can update it using the same
settings.

At the prompt Thereis an existing install at that location, update it while keeping existing settings?, if
you type yes and press Enter, the installation will proceed without additional entries.

Note: If you want to change any of the settings, you must use a new directory, or delete the old
installation before performing the new installation. You cannot overwrite an existing installation, and
you cannot use an existing directory that does not contain avalid installation. The existing installation
must be Gentran Integration Suite 4.3 or later.

The program verifies the amount of available disk space.

At the prompt Isthis server in a less secure network than the integration server?, type Yes and press
Enter.

At the prompt WiI this server need to operate on specific network interfaces?, if you type yes and
press Enter, the program returns alist of the available network interfaces available on your host.
Select the interfaces for the server to use.

Enter the TCP/IP address or DNS name for the interna interface to use to communicate with the
integration server (Gentran Integration Suite.). Press Enter to use awildcard for this address.

Verify the TCP/IP address or DNS name for the internal interface.

Enter the TCP/IP address or DNS name for the external interface to use to communicate with trading
partners. Press Enter to use awildcard for this address.

Verify the TCP/IP address or DNS name for the external interface.

Enter the port that the perimeter server will listen on for the connection from integration server
(Gentran Integration Suite). The port number must be higher than 1024.

Verify the port.

When the perimeter server isinstalled, the following message is displayed:
Installation of Perimeter Serviceis finished

Changeto theinstallation directory.
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17. Enterinst al | PS. cnd to install this perimeter server as a Windows Service.

18. Enter st art PSSer vi ce. cnd to start the perimeter server.

Installing Patches in a Perimeter Server Non-Clustered Windows

Environment

Remote perimeter servers are not automatically updated by a service pack or patch. Y ou must reinstall the
perimeter server using the new perimeter server installation file supplied with the service pack or patch.

To update aremote perimeter server in anon-clustered Windows environment:

1

Update your installation of Gentran Integration Suite 4.3 with the latest maintenance patch. Obtain the
maintenance patch file from the Sterling Commerce Support on Demand Web site, at
https.//support.sterlingcommerce.com. These patch files have a name that identifies a build number.
For example, si_43 build_4307.jar. For more information, refer to Installing the Current Maintenance
Patch (Non-Cluster) on page 32.

Locate the perimeter server patch file (ps_version_number jar file) in the install_dir\packages
directory of your installation of Gentran Integration Suite 4.3. These patch files have a name that
identifies aversion number. For example, ps 2006.jar.

Copy the file to the home directory or base directory on the remote server.

Stop the perimeter server using the st opPs. cnd command.

To begin theinstallation, type absol ut ePat h\ bi n\java -jar filenane.jar.
absol ut ePat h isthe directory name where the Java version isinstalled.

The program verifies the operating system and required patch level and the location and version of the
JDK.

Type the full path to the installation directory. If you do not want to change any settings for your
perimeter server, specify the same directory where the remote perimeter server was originally
installed.

At the prompt There isan existing install at that location, update it while keeping existing settings?, if
you type yes and press Enter, the installation will proceed without additional entries.

Note: If you want to change any of the settings, you must use a new directory, or delete the old
installation before performing the new installation. You cannot overwrite an existing installation, and
you cannot use an existing directory that does not contain avalid instalation. The existing installation
must be Gentran Integration Suite 4.3 or later.

When the perimeter server isinstalled, the following message is displayed:
Installation of Perimeter Serviceis finished

Changeto theinstallation directory.

Typest art upPs. cnd to start the perimeter server.
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Starting and Stopping Perimeter Servers in Windows

To start a perimeter server in Windows, usethe st ar t PSSer vi ce. cnd command, or use the Services
Control Panel.

To stop aperimeter server in Windows, use the st opPSSer vi ce. cnd command, or use the Services
Control Panel. To remove this perimeter server's definition as a Windows Service, use the
uni nst al | PSSer vi ce. cnmd command.

Reducing Perimeter Server Security Vulnerabilities

When Gentran Integration Suite is deployed with aremote perimeter server in amore secure network zone,
thereis a security vulnerability. An intruder may compromise the host where the proxy resides, and take
over the persistent connection to the perimeter server residing in the more secure zone. If this happens, the
perimeter server will relay all the intruder's network requests past the firewall into thisinternal zone.

To prevent an intrusion, limit the activities the remote perimeter server can perform on behalf of the proxy
to specifically those activities that the proxy needs to do for its operation.

Control these limitations by a configuration residing in the secure network zone with the remote perimeter
server, inaccessible by the proxy that could become compromised.

Granting Permissions for Specific Activities By a Perimeter Server

1. Install aremote perimeter server, choosing the option for amore secure network zone. Refer to the full
perimeter server installation instructions, as described in Installing a Perimeter Server in a More
Secure Network (Windows Non-Clustered ) on page 37.

2. Attheinstalation prompt Isthis server in aless secure network than the integration server?, select
No, which isthe option for a more secure network zone.

3. Inthe perimeter server installation directory there will be atext file named restricted.policy that must
be customized. Itsinitial contents are:

// Standard extensions get all permissions by default grant codeBase
"file:${{java.ext.dirs}}/*" {permission java.security. AllPermission;};

grant {
// Grant all permissions needed for basic operation.

permission java.util.PropertyPermission "*", "read";
permission java.security.SecurityPermission "putProviderProperty.*";

permission java.io.FilePermission "-", "read,write";
permission java.io.FilePermission ".", "read";

// Needed to allow lookup of network interfaces.
permission java.net.SocketPermission "*", "resolve";
Y

grant {
// Adjust for your local network requirements.
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// Needed to connect out for the persistent connection. Do not remove this.
permission java.net.SocketPermission "localhost:12002", "connect";

// For each target FTP Server that a FTP Client Adapter will connect to in passive
mode.

/7

// permission java.net.SocketPermission "ftphost:21", "connect"; // Control
connection.

// permission java.net.SocketPermission "ftphost:lowPort-highPort", "connect"; //

Passive data connections.

// For each target FTP Server that a FTP Client Adapter will connect to in active
mode.

//

// permission java.net.SocketPermission "ftphost:21", "connect"; // Control
connection.

// permission java.net.SocketPermission "localhost:lowPort-highPort", "listen";
// Active data port range.

// permission java.net.SocketPermission "ftphost", "accept"; // Active data
connections.

// For each target HTTP Server that an HTTP Client Adapter will connect to.
//
// permission java.net.SocketPermission "htttphost:443", "connect";

// For each target C:D snode that the C:D Server Adapter will connect to.
//
// permission java.net.SocketPermission "snode:1364", "connect"

Y

4. Edit thisfileto add permission lines for each back-end server that you intend to allow the proxy to
access. There are commented out examples for each type of server.

The first two grant sections are required for correct perimeter server operation. Do not modify these
sections.

Example
The following example grants permission to atarget FTP Server:

Note: Inthe example, servers are configured to listen on the following ports: 33001 (for FTP), 33002
(for HTTP), and 1364 (for C:D). These port numbers can be edited.

// To restrict or permit the required Host/Server to communicate with the PS, update
the “ftphost/ htttphost/snode” with

that of the Server IP and provide the appropriate PORT number where the Server
will listen. //

// For each target FTP Server

// permission java.net.SocketPermission "10.117.15.87:33001", "connect"; //
Control connection.

// permission java.net.SocketPermission "10.117.15.87:1lowPort-highPort",
"connect"; // Passive data connections.

// 10.117.15.87 indicates IP of the FTP Server for which the permission is granted
by PS for communicating with client //

// For each target HTTP Server
//
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// permission java.net.SocketPermission "10.117.15.87:33002", "connect";
// 10.117.15.87 indicates IP of the HTTP Server for which the permission is granted
by PS for communicating with client //

// For each target C:D snode

//

// permission java.net.SocketPermission "snode:1364", "connect";

// 10.117.15.87 indicates IP of the Connect Direct Node for which the permission
is granted by PS for communication //

5. Turnonrestrictions. In the install directory isthe perimeter server settingsfile:
remote_perimeter.properties.
Edit it to change the "restricted" setting to a value of true.

6. Inthefuture, any attempt by the perimeter server to access disallowed network resources will be
rejected and logged in the perimeter server log written to the perimeter server installation directory.

Performing DNS Lookup on Remote Perimeter Server

By default, a perimeter server performs DNS lookup in the main server VM. If you have limited DNSin

your secure area, you can configure the remote perimeter server to look up trading partner addressesin the
DMZ.

To enable DNS lookup to occur at the remote perimeter server, edit the perimeter.propertiesfile to change
the following parameter:

Note: Do not edit the properties files. Make al the changes in the customer_overrides.propertiesfile.

Property Name Description

<psname>.forceRemote  Enables remote DNS resolution for the perimeter server, where <psname> is the name of
DNS the perimeter server. Valid values:

¢ true - enable remote DNS resolution

¢ false - disable remote DNS resolution

Postinstallation in a Non-Clustered Windows Environment

After installing Gentran Integration Suite, you should complete the following tasks:
Sarting Gentran Integration Suite in Windows on page 44
Accessing Gentran Integration Suite on page 44
Validating the Installation on page 45
Downloading Gentran Integration Suite Tools on page 46
Performing Initial Administrative Setupsin Gentran Integration Suite on page 46
Sopping Gentran Integration Suite on page 46
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Starting Gentran Integration Suite in Windows

To start Gentran Integration Suite in a non-clustered Windows environment, double-click the Gentran
Integration Suite icon on your Windows desktop. Gentran Integration Suite starts running.

Note: It may take several minutes for Gentran Integration Suite components to initialize and start up.

If Gentran Integration Suite does not start or if you receive a message about an invalid or corrupt license
file, go to the Troubleshooting: Windows Environment section.

When startup is finished, a message like the following is displayed:

Open your Web browser to http://host: port/(interface), where host: port is the host and port number where
Gentran Integration Suite resides on your system, and (interface) is the interface used by Gentran
Integration Suite (for example, admin or dashboard).

Make a note of the URL address so you can access Gentran Integration Suite | ater.

Accessing Gentran Integration Suite

To log in to Gentran Integration Suite the first time, follow these steps:

1. Besurethat Gentran Integration Suite is started and running.

2. Open abrowser window and enter the address displayed at the end of startup.
3. Thelogin page for Gentran Integration Suite displays.
4

Type the default user ID (admin) and password (passwor d). The default login is at an administrative
level. One of your first tasks as an administrator isto change the administrative password and to
register other users with other levels of permission.

Technical Note: Changes to Network Interface Bindings

To increase the security of the Administrator Console user interface, Gentran Integration Suite version 4.3
binds only to specific network interfaces. By default, previous versions had been bound to all network
interfaces. After installing, if the URL for Gentran Integration Suite returns Page cannot be displayed, you
can adjust property settings to correct the problem.

1. Onthe server where Gentran Integration Suite resides, edit the noapp.properties.in file.
a. Locatetheadmin_host parameter. The default settings are as follows.

hostnamel is the name of primary network interface, the one given highest priority by Gentran
Integration Suite.

localhost is the name of the network interface on the server where Gentran Integration Suite
resides.

Default entries
host nanel

adm n_host. 1
| ocal host

adm n_host . 2
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b. Correct the parameters.

If nointerfaceisbeing displayed, edit hostnamel so that it correctly identifies the primary network
interface that accesses Gentran Integration Suite.

If an additional network interface needs to access Gentran Integration Suite, add an additional
admin_host entry, as shown below.

Edited entries

adm n_host . 1 = host nanel
adm n_host. 2 = | ocal host
adm n_host . 3 = host nane2

Stop Gentran Integration Suite.
Runtheset upfi | es. cnd utility located in theinstall_dir\bin directory.
Restart Gentran Integration Sulite.

For the Dashboard user interface, Gentran Integration Suite version 4.3 provides unrestricted binding to
network interfaces through the perimeter server. To restrict access to the Dashboard user interface, you can
adjust property settings so that only one network interface accesses Gentran Integration Suite.

1

On the server where Gentran Integration Suite resides, edit the perimeter.properties.in file.
a. Locatethelocalmode.interface parameter. The default setting is unrestricted, as shown below.

Unrestricted Setting (Default)
| ocal mode. i nterface=*

b. Torestrict accessto the Dashboard, enter the network interface that you want Gentran Integration
Suite to support.

Restricted Setting
| ocal node. i nt er f ace=host nanel

Stop Gentran Integration Suite.
Runtheset upfil es. cnd utility located in theinstall_dir\bin directory.
Restart Gentran Integration Suite.

Validating the Installation

After youinstal, start, and log in to Gentran Integration Suite thefirst time, you can validate theinstallation
by testing a sample business process. Follow these steps:

1

© U M~ WD

Open a browser window and enter the address for Gentran Integration Suite. This address was
displayed at the end of startup.

Enter your user login and password.

From the Administration menu, select Business Processes > M anager.
In the Process Name field, type Validation_Sample BPML and click Go!
Click execution manager.

Click execute.
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7. Click Go! You see the Satus: Success message in the upper |eft side of the page.

Downloading Gentran Integration Suite Tools

Gentran Integration Suite includestoolsthat run on a desktop or personal computer. After you install, start,
and access Gentran I ntegration Suite, you can install the following tools by downloading them from within
Gentran Integration Suite:

Note: MESA Developer Studio and Reporting Services are optional featuresthat are purchased separately
from Gentran Integration Suite. These features each require a separate license in addition to your
license for Gentran Integration Suite.

Map Editor and associated standards

Graphical Process Modeler

Web Template Designer

(If licensed) MESA Developer Studio plug-ins, including:

¢ MESA Developer Studio Software Development Kit (SDK)
¢ MESA Developer Studio Skin Editor

(If licensed) Reporting Services, which requires MESA Developer Studio if you want to use the
plug-insto create fact models and custom reports.

Conflicting I P addresses can cause problems when you download a desktop tool. See the Troubleshooting:
Windows Environment section.

Performing Initial Administrative Setups in Gentran Integration Suite

At this point, your installation is complete, and you can run Gentran Integration Suite. If you areinstalling
Gentran Integration Suite for the first time, you need to perform some initial administrative setups before
userscan use Gentran Integration Suite. For exampl e, the system administrator for Gentran I ntegration Suite
must register users and grant permissions.

For security purposes, change default user ID passwords immediately after installation is completed. See
the Editing My Account Information task in the documentation library.

Also, it isrecommended that you run several performance reports so that benchmarks are established for
tuning the system in the future. For moreinformation about preparing your Gentran Integration Suite system
for effective performance tuning, refer to the performance tuning methodology information in the
Performance and Tuning Guide.

Stopping Gentran Integration Suite

To stop Gentran Integration Suite in a non-clustered Windows environment, follow these steps:
1. Open Gentran Integration Suite.

2. Fromthe Administration menu, select Operations > System > Troubleshooter.

3. Click Stop the System and wait for shutdown to complete.
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Uninstalling Gentran Integration Suite from a Non-Clustered
Windows Environment

When you uninstall Gentran Integration Suite, the following components are affected:

Gentran Integration Suite application is automatically removed from the server.
The MySQL database is automatically removed from the server (if you are using MySQL).

Additionally, you may perform the following tasks:

Manually remove the JDK that was installed
Free any database space in Oracle or SQL Server databases

To uninstall Gentran Integration Suite from a Windows environment, follow these steps:

1. Stop Gentran Integration Suite and wait for shutdown to complete.

2. Runinstall _dir\bin\uninstal | WndowsService. cnd toremove the following Windows
services:

3.

*

*

*

*

*

Gentran Integration Suite
Opsserver

Noapp server

WebDav server

MySQL server

You should receive a message stating that the services were successfully removed. To verify their
removal, open the Services window:

a

b.

Select Sart > Settings > Control Panel > Administrative Tools (Windows 2000) or Start >
Administrative Tools (Windows 2003).

Click Services.

If the services were not removed, you must delete them from the Windows registry:

a

b.

C.

d.

Go to the Windows registry.
Locate HK_LOCAL_MACHINE\System\Current Control Set\Services.

Delete the keys for Gentran Integration Suite and Opsserver. These registry keys start with
Gentran Integration Suite.

Reboot to apply the registry changes.

If the JDK is not being used by another application, removeit:

a

Select Sart > Settings > Control Panel (Windows 2000) or Start > Control Panel (Windows
2003).

Select Add/Remove Programs (Windows 2000) or Add or Remove Programs (Windows 2003).

Select Java 2 SDK Runtime Environment Sandard Edition v<version number> and click
Remove.
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d. Select Java 2 SDK Standard Edition v<version number> and click Remove.
e. Close all windows and return to your desktop.

4. Remove the product installation folder from the Windows path:
a. Inyour Windows desktop, right-click My Computer.

Select Properties.

Click the Advanced tab.

Click Environment Variables.

In the System variables window, select Path.

Click Edit.

The system displays the Edit System Variable dialog box.

g. Deletethefollowing entrieslocated in Variable Va ue.
<install_dir>\SI\lib\jnipass\1_O\windows;
<install_dir>\mysqgl2\Sl\packages\lib\jni;
<install_dir>\mysqgl2\Sl\packages\lib\j ni\windows2000

h. Click OK.

i. Closeal windowsto return to your desktop.

-~ ® a0 o

5. Deletethe folder where Gentran Integration Suite was installed, including al subfolders. For example,
delete C:\SerlingCommerce and its subfolders.

6. If you usean Oracle or SQL Server database, these remain intact even after you remove Gentran
Integration Suite from the server. If you no longer want to reference the data, contact your database
administrator about removing the unwanted tables and recovering the database space where Gentran
Integration Suite resided.

7. After you remove Gentran Integration Suite from the server, you can remove Eclipse and any toolsthat
were downloaded to the desktop:

Note: You can remove Eclipse plug-ins without removing Eclipse. Refer to the Eclipse on-line help for
information about removing the plug-ins.

Note: MESA Developer Studio and Reporting Services are optional features that are purchased
separately from Gentran Integration Suite. These features each require a separate license in addition to
your license for Gentran Integration Suite.

+ Map Editor and associated standards
Refer to the Map Editor Guide for information about removing the Map Editor.
¢ Graphical Process Modeler

Refer to the Graphical Process Modeler Guide for information about removing the Graphical
Process Modeler.

+  Web Template Designer
Refer to the Web Extensions Guide for information about removing the Web Template Designer.
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¢ (If licensed) MESA Developer Studio plug-ins, including the Software Development Kit (SDK)
and Skin Editor.

To remove these items, follow this procedure:

a. Using Windows Explorer, locate the installation directory of Eclipse (For example,
C:\Program Files\eclipse).

b. Navigateto the featuresdirectory and delete the foldersfor anything from Sterling Commerce,
gisstudio, skineditor, and servicesdk.

c. Navigate to the plugins directory and delete the folders for anything from Sterling Commerce,
gisstudio, skineditor, and servicesdk.

¢ (If licensed) Reporting Services, which requires MESA Developer Studio if you want to use the
plug-ins to create fact models and custom reports.

Troubleshooting: Windows Environment (Non-Cluster)

Situation ~ Message or Symptom Explanation/Resolution
Installing You encounter errors or problems Explanation
during installation. Installation creates two log files, one for the first (bootstrap)
phase and a second for the actual installation phase.
Resolution
Examine the log files generated during installation:
¢ install_dinbootstrap.log
¢ install_dir\shinstallSl.log
Installing During installation, you select the Explanation
destination directory and the The command window was closed after you selected the
installation program stops running. destination directory.
Resolution
Delete the destination directory and re-start the installation
process. Do not close the command window.
Installing You started the installation program Resolution
but realize that the license file has not  \inimize the installation window, obtain the license file, and
been downloaded. then continue with the installation procedure.
Installing During installation, you identify the Resolution
initial port number and then see the Choose one:

message: Port number is already in
use.

¢ Use a different port number.

¢ Stop the service that is using the port number that you
want to use.
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Situation

Message or Symptom

Explanation/Resolution

Installing

During installation, you enter database
information and see the message:
Information is incorrect.

Explanation
One or more of the criteria for the database is incorrect.
Resolution

Click Back to redisplay the dialog box that asks for the
database information. Correct the error and click Next.

Installing

Installation appears to complete
successfully, but Gentran Integration
Suite services are not installed.

Explanation

You may have reinstalled Gentran Integration Suite on a
Windows server and chosen the same initial port.

Resolution

If this is the case, either reinstall Gentran Integration Suite in a
different directory using a different port, or follow the steps
below to uninstall the existing Gentran Integration Suite
services prior to reinstalling Gentran Integration Suite.

1 Runinstall_dir\bin\stopWindowsService.cmd and wait
for all Gentran Integration Suite Windows services to
stop.

2 Run install_dinbin\uninstallwindowsService.cmd and
log off. This cleanly removes the old Windows services
from Windows cache and verifies that there are no
scheduled jobs running in the background.

3 Delete the install_dir directory.

4 You can now install the new version of Gentran
Integration Suite at the same port.

Installing

After installing Gentran Integration
Suite, a gisinstall.* subdirectory is left
in the current working directory. This
can cause the file system to become
full.

Explanation

The Java installer is not allowed to delete the
gisinstall.*/platform_core_2000.jar because it is “in use” by the
JVM.

Resolution

Manually delete the leftover gisinstall.* subdirectory on
Windows after each installation attempt.

Starting

If Gentran Integration Suite does not
start, examine the log file in
<install_dir>\Shlogs for an invalid or
corrupt license file.

Resolution
Obtain the license file. Then restart Gentran Integration Suite.
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Situation  Message or Symptom

Explanation/Resolution

Installinga Cannot download any of the following:

desktop Note: MESA Developer Studio

tool or and Reporting Services are

resource optional features that are
purchased separately from
Gentran Integration Suite.
These features each
require a separate license
in addition to your license
for Gentran Integration
Suite.

¢ Map Editor and associated
standards

¢ Graphical Process Modeler
¢ Web Template Designer

¢ (If licensed) MESA Developer
Studio plug-ins (Software
Development Kit (SDK), Skin
Editor)

¢ (If licensed) Reporting Services,
which requires MESA Developer
Studio if you want to use the
plug-ins to create fact models and
custom reports.

Explanation

When you install Gentran Integration Suite, system files are
created that contain an internal IP address. If you install
Gentran Integration Suite behind a firewall, and your firewall is
configured to accept an external IP address from a client
computer, you may not be able to download the desktop tools
and resources. The firewall will reject the IP address from a
client residing outside of the firewall.
Resolution
Modify the system files that contain the invalid IP address.
Follow these steps:
1 Navigate to the install_dir\bin directory.
2 Enter the following command followed by the external

IP address:

patchJNLP.cmd external_IP address

Stop Gentran Integration Suite.

Restart Gentran Integration Suite.

Accessing  Attempts to access the URL for
Gentran Integration Suite display the
message: Page cannot be displayed.

See Technical Note: Changes to Network Interface Bindings
on page 44.
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Chapter 4

Installing and Configuring MESA Developer
Studio

Overview for Installing and Configuring MESA Developer
Studio

Gentran Integration Suite MESA Developer Studio is an Integrated Development Environment (IDE) that
uses Eclipse software plug-ins. Usethe MESA Devel oper Studio to connect with aGentran I ntegration Suite
instance for resource access and control of operations of Gentran I ntegration Suite, change the templ ate that
Gentran Integration Suite uses, and devel op custom services—all from within a devel opment environment.

In addition to MESA Developer Studio, the following plug-ins are available:

MESA Developer Studio SDK — for devel oping and deploying custom services and adapters.

MESA Developer Studio Skin Editor — for customizing the look and feel of Gentran Integration Suite
interface.

Reporting Services — a separately-licensed set of plug-ins used to create fact models and reports for
Gentran Integration Suite.

Note: MESA Developer Studio and Reporting Services are optional featuresthat are purchased separately
from Gentran Integration Suite. These features each require a separate license in addition to your
license for Gentran Integration Suite.

Assumptions and Prerequisites
Read the following assumptions and prerequisites prior to installing MESA Developer Studio:

Basic knowledge of Gentran Integration Suite and its architecture. Thisis especially important if you
are using MESA Developer Studio SDK to create services and adapters.

Basic knowledge of Eclipse is assumed. For more information, see the Eclipse online help or go to the
Eclipse web site.

Extensive knowledge of how to create and deploy a service.
Thorough knowledge of and experience with the Java programming language for creating services.

Sterling Commerce, an IBM Company 52



Overview for Installing and Configuring MESA Developer Studio

You have the required MESA Developer Studio (and if purchased, Gentran Integration Suite) product
licensing.

Steps to Set Up MESA Developer Studio

Setting up MESA Developer Studio is a multi-step process which should be completed in the order
described. Thefollowing is achecklist for each stage in the process. The checklist provides an overview of
the entire process. Separate instructions for completing each step are available:

1
2.
3.

o N o o

Install and configure Gentran Integration Suite.
Download and install the latest Gentran Integration Suite patch.

Download and install afull release version of Eclipse. For more information, see the download page of
the Eclipse web site.

Note: MESA Developer Studio requires specific plug-in versions. We recommend you to install
Eclipse for MESA development only. If you are using Eclipse with development projects other than
MESA, disable plug-ins that report conflicts.

Download and install the latest version of Java 2 SDK Standard Edition 5.0 (or higher) on the same PC
that you installed Eclipse. It isimportant that you have the full SDK and not just the JRE.

After installation, additional configuration is required.

Verify that MESA Developer Studio uses the correct JRE.

Install the MESA Developer Studio (and if purchased, Gentran Integration Suite) Plug-ins.
Set up Gentran Integration Suite Instance in MESA Developer Studio.

Set up Gentran Integration Suite resources to be used with MESA Developer Studio.

Eclipse Terms

Thefollowing Eclipseterms might be used in this documentation when describing MESA Developer Studio
components:

Project - All the resources related to a particular implementation reside in a project. It can contain
folders, files, and other Eclipse objects.

Workspace - Directory where work is stored.

Workbench - Ul window that contains these elements:

+ Perspective - group of views and editors in a Workbench window that correspond to a certain
project.

+ View - visua component within the Workbench and dependent on the perspective that was
selected. Used to navigate or display information such as properties or messages.

+ Editors - visua component in the Workbench used to create, change, or browse a resource.
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Configuring J2SE on Your PC

In order for Eclipseto work correctly, you must have Java 2 SDK Standard Edition 5.0 (or higher) installed
onthesamePC youinstalled Eclipse. Y ou need to havethefull SDK installed. The JRE aloneisnot enough.
Y ou must close Eclipseto download and install the JDK. After installing J2SE, you must configure your PC
to useit.

To configure your PC for the new JDK:

1. Select Sart > Settings > Control Panel > System (Windows 2000) or Start > Control Panel >
System (Windows 2003).

Click the Advanced tab.

Click Environment Variables.

Under System Variables, click New.
Complete the following and click OK:

¢ Variable Name - type JAVA_ HOME.

+ Variable Vaue - type the directory path for the location where you installed the J2SE SDK. The
default location is C:\j2sdk5.0\.

6. Click OK to exit.

a b~ 0D

Verifying that MESA Developer Studio Uses the Correct JRE

In addition to adding a home directory on Windows for this JDK instance, you must also verify that MESA
Developer Studio uses the correct JRE.

To verify the MESA Developer Studio JRE:

1. Open Eclipse.

2. From the Window menu, select Preferences.

3. Expand the Java section and select I nstalled JREs. The Installed JREs window appears.

4. If C:\j2sdk5.0 isnot listed (location and version may be different, but version should be as listed or
higher), click Add and go to next step.

If it islisted, make sureit is selected and click OK. You are ready to use MESA Developer Studio.
5. Complete the following and click OK:
¢ JRE Name - type any name for this JRE.

¢ JRE home directory - click Browse to select the home directory you defined in the Configuring
J2SE on Your PC section.

¢ Default VM Arguments - leave blank.
+  JRE system libraries - make sure Use default system libraries is selected.
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6. Click OK to exit.

Starting the WebDAV Server

MESA Developer Studio usesaWebDAV server to provide access to Gentran Integration Suite resources,
including MESA Developer Studio plug-in updates. ThisWebDAV server is automatically installed with
Gentran Integration Suite for use with MESA Developer Studio.

The WebDAYV server starts automatically with Gentran Integration Suite in Windows.

Gentran Integration Suite (Windows)

The WebDAYV server that is used with MESA Developer Studio isimplemented as a service, and starts
automatically when you start Gentran Integration Suite (startWindowsService. cmd). When Gentran
Integration Suite is stopped (stopWindowsService.cmd), the WebDAV server, and MySQL if used,
remains running. Thisis necessary to start and stop instances of Gentran Integration Suite from within
Eclipse and MESA Developer Studio.

Y ou can stop the WebDAYV Server Service using stopWebdaviindowsService.cmd. AlSo, when
Gentran Integration Suite and WebDAV Server Service are running and WebDAV Server Service gets
stopped Gentran Integration Suite (and MySQL if used) will remain running. The logfilename of the
WebDAYV Server Serviceisdav.log.

Installing MESA Developer Studio Components

You must install and configure MESA Developer Studio to connect with the desired Gentran Integration
Suite instances for resource access and for control operations of Gentran Integration Suite from within
MESA Developer Studio. Use this procedure to install Gentran Integration Suite plug-ins, as well.

Changing Proxy Preferences

Y ou might need to change you proxy server settings to enable an HTTP proxy connection between the PC
where you have Eclipse installed and the server where Gentran Integration Suite is installed.

To change proxy settings:

1. From the Windows menu, select Preferences > Install/Update.
2. Under Proxy settings, type your proxy information.

3. Click OK.
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Installing New Features
Toinstall MESA Developer Studio:

1
2.

0.

N o g b~ w

Open Eclipse.

Select a default workspace folder location. You can add additional workspace folder locations at any
time. The Package View in the lower |eft area of the MESA Developer Studio workspace displays a
local explorer view of your project folders. This enables you to store files that you check out.

From the Eclipse Help menu, select Software Updates > Find and install.
Select Search for new featuresto install.

Click Next.

Click New Remote Site.

Complete the following information and click OK.

+ Name —type adescriptive name for the application server.

¢ URL —typethe IP address or name of your server. Format is
http://<servername>:<WebDAVportnumber>/eclipse.

Your new site will appear in the list of sitesto include in the search.
Select the check-box to the left of the new site. Click Finish.

The system verifies the selected site and displays the results. On the search results page, expand the
update site node and select from the following plug-ins, according to your licenses:

¢ MESA Developer Studio
*  Service SDK
¢ Skin Editor

+ Gentran Integration Suite (automatically selects all three Gentran Integration Suite plug-ins: Fact
Model Editor, Report Editor, and Report Format Editor)

Cautions:
¢ Do not change the default installation path for the plug-ins.

+ If you are selecting Gentran Integration Suite, you must also select the MESA Developer Studio
plug-in (unless you have already installed MESA Developer Studio). Dependencies require that
the MESA Developer Studio plug-in beinstalled either before or at the same time as Gentran
Integration Suite plug-ins.

Click Next. Accept the terms of the license and click Next.

10. Click Finish.
11. Click Install All to accept the feature verification.

Y ou must restart Eclipse for the changes to take affect.
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Setting Up a Gentran Integration Suite Instance

Y ou can only view resources that are available for the specified Gentran Integration Suite instance. If a
desired resource resides in a different Gentran Integration Suite installation you must configure a new
instance in MESA Developer Studio to work withiit.

Note: If you areinstalling Gentran Integration Suite, you must complete this task.
1. From the Window menu, select Open Per spective > Other.
2. Select MESA Developer Studio and click OK.
3. Inthe MESA Developer Studio view in the upper left, right-click and select New instance.
4. Complete the following information and click Finish:
¢ Hostname - name of machine for Gentran Integration Suite install.
¢ Port - WebDAV port assigned at install.
+ Name - name you assign to this Gentran I ntegration Suite connection.
¢ User name - valid Gentran Integration Suite user name (for example, admin).
+ Password - valid Gentran Integration Suite password.

MESA Developer Studio attempts to establish a connection to the instance using the WebDAV server.
The status of the instance is displayed:

¢ Red - theinstance has not been started.
¢ Yelow —theinstance was started but is not yet running.
¢ Green—theinstanceisrunning.

Note: Refresh the workspace to see a newly added environment.

Editing Connection Information

Onceyou have set up Gentran I ntegration Suite instance for use with MESA Developer Studio, you can edit
the connection information, view configuration details, test the connection, and refresh the connection.

To edit the connection information:
1. Right-click on the instance name.
2. Select Edit.

3. Edit the settings as needed.

4

Click Finish.
MESA Developer Studio attempts to establish a connection to the instance using the new information.
The status is displayed (green, yellow, or red) according to the status of the instance.
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Viewing Configuration Details

To view configuration details, double-click on the instance name.

Note: The ports on the Overview window are static. Only the ports present at install are displayed. Any
changes or additions made after installation are not displayed.

Refreshing the Instance

Use Refresh if you have locked or unlocked business processes and maps through in Gentran Integration
Suite, and you want to see their current statusin MESA Developer Studio.

To refresh Gentran Integration Suite instance connection:
1. Right-click on the instance name.
2. Select Refresh

The Progress Information window appears and closes automatically when the refresh processis
complete. The statusis displayed (green, yellow, or red) according to the status of the instance.

Installing Additional MESA Developer Studio Components and
Updates

You can install additional MESA Developer Studio components not installed at the time of the original
installation at any time. To install additional components follow the steps listed in the section Installing
MESA Developer Sudio Components. The system verifies that the license file has newly licensed
components and installs them.

The system verifiesthat the additional components are licensed in Gentran Integration Suite. If not, you are
asked to provide new connection parameters to Gentran Integration Suite instance that has the appropriate
licensefor the additional MESA Developer Studio components. Oncethelicense check iscompl ete, the new
components are activated.

If you are updating an existing component, restart Eclipse in order for the new component to be updated.

Installing Reporting Services Plug-Ins

Reporting Services works with Gentran Integration Suite MESA Developer Studio, which is an Integrated
Development Environment (IDE) that uses Eclipse software plug-ins. The Reporting Services Fact Model
Editor, Report Editor, and Report Format Editor are all accessed as Eclipse plug-ins.

Note: MESA Developer Studio and Reporting Services are optional featuresthat are purchased separately
from Gentran Integration Suite. These features each require a separate license in addition to your
license for Gentran Integration Suite.
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To set up the Reporting Services plug-ins:

1

a ~ D

Follow the procedures for the MESA Developer Studio configuration.

Note: When compl eting the procedure Installing MESA Developer Sudio Components, ensure that
you select both the Reporting Services plug-ins and the MESA Developer Studio plug-in for download
and installation in Eclipse.

Caution: The MESA Developer Studio plug-inis a prerequisite for the Reporting Services plug-ins.
You must install it either with or prior to installing the Reporting Services plug-ins.

After installing the MESA Developer Studio and Reporting Services plug-ins, complete the following
tasks:

Start the WebDAV server for your Gentran Integration Suite instance.
Start the Event Listeners.
Configure your Eclipse installation to point to Gentran Integration Suite WebDAV server.

Customize the Window Perspectivein Eclipse to include Sterling Commerce Reporting Services. This
makes the Reporting Services options available directly from the Eclipse menus. In Eclipse, select
Window > Customize Per spective. In the Shortcuts pane on the left, select Sterling Commer ce
Reporting Services and click OK.
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Chapter 5

Configuring Properties

After installing Gentran Integration Suite, you must set up afew property and script filesin order for
Gentran Integration Suite to run properly. This chapter describes the properties you must set up before
configuring Gentran Integration Suite to run according to your business needs.

Properties to Prevent Cross-Site Script Vulnerabilities

In some cases, data to and from Gentran Integration Suite can contain HTML characters that impact the
display and the original intent of the input. In addition, data can be input that contains malicious HTML,
such as commands embedded within <SCRIPT>, <OBJECT>, <APPLET>, and <EMBED> tags.

In Gentran Integration Suite, potentially malicious data being output to the browser can be rendered
harmless by implementing the provided encoding mechanism. This prevents these malicious scripts from
being run by the browser.

Any presence of these characters triggers Gentran Integration Suite to safely encode the data.
For more detailed information about malicious scripts, see the following articles:

CERT Advisory, MaliciousHTML Tags Embedded in Client Web Requests. Available from the CERT
web site.

CERT Advisory, Frequently Asked Questions About Malicious Web Scripts Redirected by Web Sites.
Available from the CERT web site.

Setting the Database Connection Properties

Database properties are configured during installation. They are put in
install_dir/properties/jdbc.propertiesfiles.

Note: After making modifications to the required files, rebuild the resource jar.
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To enable database connection pooling, create the pool, configure the data source entry for JINDI, and
specify it as the datasource name. For connection pooling used by other application servers refer to the
vendor’s manual on connection pooling.

Properties for LDAP User Authentication

This section assumes you understand how LDAP servers work. Sterling Commerce also recommends that
you read the following documents on LDAP technology:

W. Yeong, T. Howes, and S. Kille, RFC 1777 - Lightweight Directory Access Protocol. March 1995.
Available at http://rfc.net/rfc1777.html.

Mark Wilcox, Implementing LDAP. Wrox Press, 1999.

By default, all authentication is performed against the Gentran Integration Suite database. When a user
entersalogin ID and password, it is validated against the login ID and password that is stored in the
database. Thisrequires the administrator of Gentran Integration Suiteto set up login IDs and passwords for
each user.

Alternatively, the Application Console supports L DAP-based user authentication. Y ou may choose to use
an LDAP server for authentication. When using LDAP, the users, user groups, and access control must be
set up in Gentran Integration Suite.

Gentran Integration Suite a so supports password expiration through LDAP. Y our custom code for user
authentication is interfaced with the Gentran Integration Suite authentication mechanism. If your custom
code contains Expi r el nDays with anumeric value of <X>, then a message to reset the password appears
on the Gentran Integration Suite home page. If the map contains ChangePasswor dLi nk, then the message
contains alink to the location specified. Clicking on the link opens a new window with the given
ChangePasswor dLi nk.

Since the various implementations of LDAP handle password expiration differently, a sample
Y FSLDAPAuthenticator is provided as an example of one particular implementation. Thisislocated inthe
install_dir/xapidocs/code_examples directory.

To set properties for LDAP-based authentication, do the following:
1. Install the LDAP server (seetheinstallation instructions from your LDAP server vendor).
2. If aJAAS-compliant provider is used, create a JAAS configuration file with the following lines:

LDAP
{

/1 refer to the JAAS conpliant service provider for the login
nodul e details.
<Cl ass Nane of the Login Mdule as specified by the Security
provi der> required
debug=t rue;
b
3. Specify the LDAP properties described in the following table:
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Property

Description

WebLogic startWLS startup file

-Djava.security.auth.login.config

If you are using JAAS and WebLogic, specify the full path to your
JAAS configuration file.

In the Configurator Ul

Configure organizations, organization units,
and users.

All users who need to access Gentran Integration Suite must be
set up under the LDAP server. All Gentran Integration Suite
users must belong to the same organizational unit.
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Chapter 6

Configuring Utilities

Gentran Integration Suite supplies sample script files (. sh for UNIX and . cmd for Windows) that you must
customize using the directions provided in this chapter.

Thischapter describesall the utilities supplied by Gentran Integration Suite, organized by the order in which
you are likely to use them. It describes generic customizations that apply to most or all utilities. Further
details specific to each utility are provided throughout the rest of this guide.

Installation Utilities

Note: On UNIX, al utilitieswithin theinstall_dir/bin directory must have permissions set to 755.

Installation utilities enable you to install Gentran Integration Suite. These utilities are present in the
install_dir/bin directory. Some of the utilities used for installing the various configurations of Gentran
Integration Suite are the following:

loadDefaults

This utility loads the standard installation database configuration, known as the "factory defaults”.
dbverify

This utility verifies the changes between your database setup and the entity XML files.

Loading Gentran Integration Suite Database Factory Defaults
To load Gentran Integration Suite database factory defaults:

1. Load the defaults, using the script applicable to your operating system. From the command line, run
| oadDef aul ts. sh on UNIX and Linux or 1oadbpefaults.cmd on Windows and pass the absolute
file path to the installer:

| oadDef aul ts. sh
install _dir/installed data/platformfactorysetup/installer.xmn
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Note: If the factory default installation stops before it isfinished, afile name "installer.xml.restart" is
created. Thisfile recordsthelocation where the installation was stopped, and it is used the next time
the factory defaults are installed.

Verifying the Database

Gentran Integration Suite provides a database verification and correction tool to ensure database schema
integrity. To set up the Database Verification Tool:

1. From the command line, runthedbveri fy. sh or dbveri fy. cnd script and pass the userlD and
password parameters as follows:

dbverify.sh/cnd userld password
Note: When using Oracle, modify the yfs.tables.sql file to reference your newly created tablespaces.

2. If you want to ignore the third-party tables when verifying the database, modify thedbveri fy. sh (or
. cmd on Windows) script, whichis located in theinstall_dir/bin folder.

Add the -Dlgnore3rdPartyTables=Y parameter as specified in the below example. The third-party
tables are not defined in Gentran Integration Suite entity XML or extension XML file. For example,

% AVA_HOVE% bi n\j ava - Dl gnor e3rdPartyTabl es=Y

com yantra.tool s. dbveri fy. DoVeri f yConmandLi ne -b % NSTALL% - u YAJSERNAMEY - p
YPASSWD% - d YDORI VER% -url %JRL% -g Y -DT

% NSTALL% t enpl at e/ api / YFSDat aTypes. xm

Note: If you have custom or third-party tables in your database and you receive an exception while
running thedbveri fy. sh (or. cnmd on Windows) script, use this parameter to ignore the custom or
third-party tables.

3. Thedifferences between the entity XMLs and the database are generated in the form of SQL scripts,
which can be run against the database to rectify the differences. The following scripts are generated:

¢ EFranme_Sequence. sql - Thisscript createsall of the additional sequences that need to be
created.

Note: If you are using a Microsoft SQL Server 2000/2005 database, EFr ane_Sequence. sgl isnot
created when you run the dbverify command.

Note: When reducing the size of a column, acomment will be logged in the
EFr ame_Tabl eDr ops. sql rather than asqgl statement in the EFr anme_Tabl eAl ter s. sql .

¢ EFranme_Tabl eChanges. sqgl - Thisscript contains al the table column differences that need to
be applied on the database schema. Modify thisfile to reference your tablespaces.
¢ EFrame_Tabl eDrops. sql - Thisscript removes any extratables in the database.

¢ EFrame_I| ndexAdds. sql - Thisscript adds al of the indexes that need to be created in the
database. Modify thisfile to reference your tablespaces.

¢ EFrane_| ndexDr ops. sql - Thisscript removes any extraindexes in the database.

Sterling Commerce, an IBM Company 64



Installation Utilities

¢ EFrame_Text | ndexUpdat es. sql - Thisscript contains al the text search indexes related
differences that need to be applied on the database schema.

4. Runinstall_dir/database/scripts/dbtype/l mportExport_View.sql and Interop_Views.sqgl scripts
manually, where dbtype is either mySQL, DB2, Oracle, SQL server 2000 or SQL server 2005,
depending on what you are using for aDBMS.

For example, if thereisamismatch in the size of a datatype for a column [varchar2(20) to
varchar2(40)] that has an associated index, the DBV erify tool generates SQL statements for:

+ Dropping the index
¢ Changing the size of the datatype for the column
+ Creating the new index

All three SQL statements listed above appear in different *. sql files. The appropriate *. sql files
must be run in a proper order asfollows:

a  RunEFrane_| ndexDr ops. sql for dropping the index.

b. RunEFrame_Tabl eChanges. sql for atering the size of the datatype for a column.

Cc. RuntheEFrane_| ndexAdds. sql for creating anew index.

If the SQL statements are not run in the sequence as mentioned above, it resultsin script failure.
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Appendix A

Configuring for a Non-English Environment

You caninstall Gentran Integration Suitein an English or a non-English environment. By modifying afew
system settings, you can then configure Gentran Integration Suite for your locale.

This section includes the following topics:
Installing the Language Pack on Windows on page 66
Installing on a Remote Computer on page 66
Loading Gentran Integration Suite Language Pack Factory Defaults on page 67
Configuring Encodings for Gentran Integration Suite on page 67
Configuring Locales on page 69

This chapter also explains how to install, load the factory defaults, and check the import mode of Gentran
Integration Suite language packs.

Installing the Language Pack on Windows

Toinstall Gentran Integration Suite language pack on Windows, insert the language CDs that you received
from Sterling Commerce into your CD-ROM drive, open the Win directory, and run the set up. exe
command.

Note: Beforeinstaling the language pack be sure that you have successfully installed Gentran Integration
Suite.

Installing on a Remote Computer

Toinstall Gentran Integration Suite language pack on a Remote Computer, you can install Gentran
Integration Suite Language Packs onto any supported remote UNIX server. Y ou cannot install Gentran
Integration Suite Language Packs onto a remote Windows server.
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Loading Gentran Integration Suite Language Pack Factory Defaults

If you received any language CDs from Sterling Commerce, FTP the setup.bin file from the appropriate
operating system directory of the CD-ROM to the remote UNIX server.

Loading Gentran Integration Suite Language Pack Factory
Defaults

To load the language-specific factory defaults run the 1oadbpefaults. sh script for UNIX and Linux or
the loadbefaults.cmd script for Windows available in the install_dir/bin directory and pass the
locale-specific instaler file. For example:

loadDefaults.cmd install dir/database/FactorySetup/install/
<language>_<country>_locale_installer.xml

The default locale that is shipped with the CD isj a_JP.

Loading Gentran Integration Suite Language Pack Translations

Prior to loading Gentran Integration Suite Language Pack factory defaults, be sure that you have
successfully completed all instructionsin the database tier software chapter.

To load the language pack trandation with custom localization literals, run the LocalizedStringReconciler
tool in the IMPORT mode from the install_dir/bin directory as follows:

ant -f localizedstringreconciler.xml import
-Dsrc= /database/FactorySetup/XMLS

Thistool first inserts the value specified in the
<from_language> <from_country>_ycplocalizedstrings <to_language> <to_country>.propertiesfile
present in theinstall_dir/database/Factory Setup/X ML S/<language>_<country> directory into the database.

Note: Verify that your locale settings such as currency, time format, date, and so forth, are correct.

Switching Gentran Integration Suite Base Language

The base language for the Application Configurator can be switched only once.

Configuring Encodings for Gentran Integration Suite

Language settings for Java applications involve both character sets and encoding:

A character set isaset of characters (letters, numbers, and symbols such as#, $, and &) that are
recognized by computer hardware and software.
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Configuring Encodings for Gentran Integration Suite

An encoding is arepresentation of datain a particular character set. An encoding set is a group of
encodings.

For information about basic and extended encoding sets, see the java web site.
The default encoding for Gentran Integration Suite is 8-bit Unicode Transformation Format (UTF-8).

Gentran Integration Suite provides two property filesthat contain supported encoding sets. These properties
filesresidein theinstall_dir/properties directory.

encodings.properties — Contains the default encoding set used in Gentran Integration Suite interface.
encodings_large.properties — Contains all supported encoding sets.
The default encoding set in Gentran Integration Suite includes the following encodings:
UTF-8
| S0-8859-1
| SO-8859-5
US-ASCII
ISO_8859-1
EUC-JP
UTF-16
SO-2022-JP

Y ou are not limited to the encodings in the encoding.properties file. Gentran Integration Suite enables you
to configure the encodings properties files to expand the number of encodings you can use.

To configure your encoding set:
1. Stop Gentran Integration Suite and wait for shutdown to compl ete.
2. Changetotheinstall_dir/properties directory.

3. Openthe encodings large.properties file. Select the encodings you want to add to the
encodings.propertiesfile.

4. Open the encodings.properties.in file.

5. At the end of the encodings.properties.in file, add the encodings you selected from the
encodings_large.properties file. When adding encodings from one file to the other, first copy the
encodings as they appear in the encodings_large.properties file. After adding the new encodings,
ensure that the index numbers are consecutive. If the index numbers are not consecutive, change the
index number or numbers as needed. For example, encoding54 cannot follow encodingé. Inthis
example, change encoding54 t0 encoding?.

The first name in the definition (before the comma) is the name that will appear in the Gentran
Integration Suite user interface. You can change this name to make it more descriptive. For example:

encoding4 = 819,IS08859_1
may be changed to

encoding4 = WesternEurope,IS08859_1
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1SO8859 1 isthe Java canonical hame and should not be changed.

6. Updatethefirst line in the encodings.properties.in file (numberof). Change numberof to the number of
encodings added to the file. For example, if the current value is numberof = 6 and you add 5 new
encodings, the new value is numberof = 11.

numberof indicates the total number of encodings located in the file. You must update numberof to
ensure that the encodings you added will be visible in the user interface.

Changeto theinstall_dir/bin directory.
Runthe setupfiles.sh script or the setupfiles.cmd script (Windows only).
Start Gentran Integration Suite.

Configuring Locales

Gentran Integration Suite runsin any locale that Java supports. If you want to run Gentran Integration Suite
in a non-default locale, then configure your environment to the specific locale you want to use.

To configure your operating system as a non-English environment, consult your operating system’s
documentation.To determine and set the locale in a UNIX or Linux environment:

1. Enterlocale-a. A list of localesis displayed.
2. Setyour locale by entering:
¢ export LANG <locale>
¢ export LC_ALL <locale>
Example to set the locale to Japanese (on Solaris):
» export LANG ja_JP
e export LC_ALL ja JP
Note: Some UNIX shells require the setenv command instead of the export command.
To determine and set your locale in a Windows environment:
1. Select Control Panel > Regional Options> General tab.
2. Fromthe Your locale (location) list, select the language and location.
Note: Click Set Default and select the locale from the Set the appropriate locale list.
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